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ABSTRACT 

Simard, Y., 1. McQuinn, M. Montminy, C. Lang, C. Stevens, F. Goulet, J.-P. Lapiene, J.-L. 
Beaulieu, J. Landry, Y. Samson and M. Gagné. 2000. CH2, Canadian Hydroacoustic Data 
Analysis Tool 2 User's Manual (version 2.0). Can. Tech. Rep. Fish. Aquat. Sci. 2332: vii 
+ 123 pp. 

CH2 is the acronym for Canadian Hydroacoustic data analysis tool 2. It is a Windows 
95@ Multiple Document Interface (MDI) C++ application, developed by the Department of 
Fisheries and Oceans within the framework of the Data Analysis Tools (DAT) project of its 
National Hydroacoustic Program (NHP). It is dedicated to the display and processing of the 
standard HAC (Simard et al. 1997) multi-channel (multiple frequencies or beams) multi- 
echosounder acoustic data produced by the CHI acquisition and real-time monitoring module 
(Simard et al. 1998). Data can originate from various analog or digital echosounders (e.g., 
Biosonics 102 type, Sirnrad EK500, or EY500). CH2 version 2.0 includes several editing 
TOOLS, to edit, eliminate, ignore, threshold, filter, or correct the raw HAC data, without erasing 
any original information. It also incorporates multi-channel classification tools, to partition the 
acoustic data into echo categories according to user decisions, and multi-channel echointegration 
capabilities for each echo category. The user can always track the various processing steps that 
have been applied to the original raw data. CH2 holds full undo and redo facilities for the various 
operations applied to the raw data. Edited files can be saved under the standard HAC format and 
contain the raw data plus the parameters of the editing/classification operations. The 
echointegration data are exported in ASCII text files that are directly usable by common data 
analysis or visualisation packages such as worksheets, statistical packages, and 2-D and 3-D 
mapping packages. 



Simard, Y., 1. McQuinn, M. Montminy, C. Lang, C. Stevens, F. Goulet, J.-P. Lapierre, J.-L. 
Beaulieu, J. Landry, Y. Samson and M. Gagné. 2000. CH2, Canadian Hydroacoustic Data 
Analysis Tool 2 User's Manual (version 2.0). Cm. Tech. Rep. Fish. Aquat. Sci. 2332: vii 
+ 123 pp. 

CH2 est le sigle pour Canadian &droacoustic data analysis tool 2. 11 s'agit d'une 
application Windows 95" CU MD1 ("multiple document interface"), developpée par le 
Ministère des Pêches et Océans dans le cadre du projet Data Analysis Tools (DAT) du 
Programme National en Hydroacoustique (NHP). Elle est dédiée à la visualisation et au 
traitement des données acoustiques multi-canaux (fréquences ou faisceaux multiples) et multi- 
échosondeurs de format standard HAC (Simard et al., 1997), acquises par le module 
d'acquisition et de monitorage en temps réel CH1 (Simard et al., 1998). Les données peuvent 
provenir de divers échosondeurs analogiques ou numériques (e.g., type Biosonics 102, Simrad 
EK500 ou EY500). La version 2.0 de CH2 comprend plusieurs fonctions d'édition, pour éditer, 
éliminer, ignorer, seuiller, filtrer ou corriger les données brutes HAC, sans effacer aucune 
information originale. Elle inclut également des fonctions de classification multi-canaux, pour 
partitionner les données acoustiques en catégorie d'échos selon les décisions de l'usager, ainsi que 
des fonctions d'échointégration multi-canaux par catégorie d'échos. L'usager peut toujours 
retracer les divers traitements qui ont été appliqués aux données brutes. CH2 incorpore des 
fonctions complètes pour défaire ou refaire les diverses opérations réalisées sur les données 
brutes originales. Les fichiers édités peuvent être sauvés sous le format standard HAC contenant 
les données brutes plus les paramètres des opérations d'édition ou de classification. Les données 
d'échointégration sont exportées dans des fichiers texte ASCIi qui sont directement utilisables 
par les logiciels communs d'analyse ou de visualisation de données, tels les chiffriers, les 
logiciels statistiques, et les logiciels de cartographie et de visualisation tri-dimensionnelle. 





Fisheries and Oceans Canada 
Pêches et Océans Canada 

PRODUCT OF 
THE NATIONAL HYDROACOUSTIC PROGRAM DATA ANALYSIS TOOLS PROJECT 

INTRODUCTION 

In 1995, the Canadian Department of Fisheries and Oceans (DFO) launched a five-year 
priority research program to improve the use of hydroacoustics in fish stock monitoring and 
estimation, which is now known as the DFO National Hydroacoustic Program (NHP). One of the 
NHP thematic projects was dedicated to the development of data analysis tools (DAT) to collect 
and process the data, from the initial step of raw data acquisition up to the final production of 
fish species biomass estimates and maps with their confidence intervals (Figure 1-1). The first 
NHP-DAT product was the definition of a standard data format for multi-channel hydroacoustic 
data, the HAC format (Simard et al. 1997), which later became an international data format in 
fisheries acoustics (Anon. 1999). The second product was a multi-channel, multi-echosounder 
data acquisition tool, the CHI' software (Simard et al. 1998). The third and final product of this 
first phase of the NHP-DAT was the second software module, CH2, which is dedicated to the 
processing of the multi-channel raw data produced by CHI and their echointegration by channel 
and species. 

The Version 2.0 of CH2 includes most of the basic functions covered in steps 3 and 4 of 
the data processing line of Figure 1- 1 for al1 data channels. Specifically for the editing step, these 
functions are: modification of the amplitude threshold, the acoustic calibration parameters, and 
GPS positions; introduction of GPS positions for files lacking such information (e.g., files 
digitised by CHI from archived magnetic tapes); erasing of unwanted signals (i.e., setting 
amplitudes to zero); labelling some areas as missing data; and filtering the data according to the 
duration of the signals. The classification functions are presently limited to the partitioning of the 
multi-channel spatial data according to user decisions based on the nature of the echoes, i.e., 
there are no automatic echo classification functions. The partitioning and the editing are made 
using several geometric tools to define regions under the various horizontal (ping sequence, time, 
distance) or vertical (surface or bottom locked representations) display modes. The multi-channel 
data can always be displayed according to the user's choice of horizontal or vertical mode and of 
range limit or palette and with the maximum possible zoom on the raw data. The echointegration 
function produces s, (Le., MVBS, mean volume backscattering coefficiertt) or s, (area 
backscattering coefficient) (for definition of units, see Mac Lennan and Femandez 2000) ASCII 
files for each chosen channel and echo classification category, with their corresponding metadata. 

t "CH" are also the letters identifying a farnous Canadian hockey tearn in the 1950s and 1960s, when the NHL had 
only 6 teams. 
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Figure 1-1. The seven data handling steps of the DAT plan. 

It includes the possibility of changing the echosounder calibration parameters stored in the raw 
HAC file as well as the average sound speed and absorption coefficients. Al1 the editing and 
classification operations are added to the raw data files as new tuples (see Simard et al. 1997), 
thus preserving the original information. Al1 operations applied to the data are labelled by a user 



name, wliich can be used duriiig subsequent data analysis steps. The operations can be changed 
or erased using the full undolredo features of CH2. The CHI and CH2 tools of the NHP-DAT 
series define a structured way to collect, edit, classify, and store the Iiigh-resolution data 
produced by various echosounders, single or mwlti-channel, under an international standard data 
foriiiat, and to geiierate a ilniforni data bank that cati be used for direct data comparisons and for 
future research in acoustics (e.g., the developnient of robi~st echo classifïcation algorithms) or for 

I anabsk 2 
Various One common tool Edition, interpolation, 
echosounder unique standard classification, * napping, 
types and archived data format integration estimation, 
data ban ks TS visualization 

Figure 1-2. Orgatiization of the DAT software modules and HAC standard data format. 

monitoring fish stocks (e,g., historical review of abundance and vertical and horizontal 
distributions). 

The current document is the user's niani~al and reference for CH2 version 2.0. Much of 
this iiiforiiiation is also available from the CH2 on-line help. The HAC tuples or files considered 
by CH2 are those defïned by the HAC version 1 .O report (Siniard et al. 1 997) plus the edition 
tuples added by the NMP-DAT team between 1997 and 2000. Additional HAC tuples that may 
have been added by other software developers in the mean time and whose detailed definitions 
have not yet been provided or accepted by thc HAC iiiternational coiilmittee, are simply ignored 
by CH2 iinless the basic HAC syntax rules indicating the tiiple length has not been observed. 
Another tool of the NH1'-DA'I' project, HAC-trtrfc (Figure 1-2), is designed to read, display in 
ASCII text, rectify or translate *.fIAC standard data format files to and from other former 
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formats. CH3 is presently left to the user's choice since many commercial software packages are 
already able to directly use the echointegration ASCII files produced by CH2. These include 
geostatistical packages, GIS, and other 2-D or 3-D data viewing packages. 

In this manual, the "i" is often used as a separator for the menu hizrarchy (e.g., Edit / 
Echo category list, View / Properties). Capital letters are used to identiîy the specific CH2 fields 
and menus, as they appear in the windows and dialog boxes, and important key words to operate 
CH2. CH* suite labels are in bold and italic. The term "group" is sometimes used to specify a 
group of fields or tools associated with the same function and assembled in identified portions of 
the dialog boxes or separated by a line in menus. The term "active" is used to identiîy the part of 
the program (e.g., a selected echograrn window, a dialog box) or the data (e.g., a given HAC data 
channe1 or file) cunently in use. The text is intentionally redundant for some portions that are 
common to different functions. This was done to provide the most direct access to the user who 
wants to rapidly find the complete information on the subject he is looking for. As this manual is 
a reference book, we did not expect the user to read the entire manual but only the sections 
specific to his needs. Occasionally, detailed basic information is provided, which may seem too 
much to acoustic experts or to other readers. This was done to provide self-contained accurate 
information at the right place for non-experts and for an open and complete reference to the data 
processing by CH2, to avoid the black box syndrome. 



INSTALLATION 

This chapter lists the requirements to use CH2 and gives the installation information. 

2.1 Material 

a One CH* CD-ROM containing CH2 version 2.0; CH1 version 2.1.1, HAC-trafic 
version 1.8 and the on-line help documents and installation file; an Office97 Excel" 
file narned HEI-format-verl.3.xls presenting echointegration results in ASCII tab- 
delimited format (*.hei): the ExcelB file TplPos.xlt that is linked with CH2 to edit 
positions via ~xcel", examples of data files of original HAC raw data, with or without 
edition and classification tuples; *.eip configuration files for recalling echointegration 
settings; sample colour palettes (*.pal); and CHI configuration files (*.chl). 
The present user's manual. 

2.2 Requirements 

A Pentium II PC 120 MHz or higher, a minimum of 64 Mb of RAM, a CD-ROM drive, 
large data storage capacity (hard disk or other fast storage devices), ~indows95/98@ 
environment, and ~ i c r o s o f t ~  Excel 97. CH2 has been tested mostly with the version 
OSR2 of ~ indows95@ in use in the DFO Laurentian Region between 1998-2000. The 
minimum video display resolution is 800 x 600 pixels, but the use of 1024 x 780 pixel 
or higher resolution is highly recomrnended. Large font display configurations is only 
possible with 1024 x 780 pixel or higher resolutions. It is not recomrnended because it 
affects proper display of the dialog boxes. 

2.3 Software installation 

As indicated in the file readme.txt of the CH2 version 2.0 CD-ROM: 
a Execute the Setup.exe programs located in the CH1 and CH2 folders of the CH* 

version 2000 CD-ROM. 
a Copy the HEI-format-verl.3.xls file and examples of the CHI configuration files 

(*.chi) and HAC data files, located in the CHl\Config and HAC folders, to folders in 
your PC Windows 95198~ environment. 





GETTING STARTED 

This chapter is a brief tutorial for busy users wanting to rapidly explore CH2. This should 
not replace reading the following chapters, which are essential to properly operate CH2. 

1. To start CH2, click the CH2 icon. After clicking on the opening window (Figure 4-2.), the 
operator's list dialog box opens (Figure 4-3). Register as an operator using the Add button. 
Then click on the Select button to choose your name in the operators' list, and click OK. 

2. Open a HAC file using the Open tool. This version 2.0 of CH2 does not include the 
possibility of reading HAC files that do not conform to the standard HAC format version 1.0 
(Simard et al. 1997). If the file has not been previously edited by CH2, CH2 will build an 
index and will check for enors in the file and display messages if any are found. Then, a 
dialog box opens and shows the channels that the file contains. By selecting a channel in the 
Software channel ID box, its parameters are displayed. Select the channel(s) you want and 
click on the View button. 

3. Pointing on a channel echogram, right-click and select Edit palette to configure a palette for 
the channel (as in CHI). Palettes are channel-specific. You can define the default palette used 
at channel opening with the Tools / Options menu. Repeat for the other channel echograms. 
Tile your channels to see them al1 simultaneously. The status bar displays the information at 
the pointer location. 

4. Use the right mouse button to change the X-Z display mode for the active channel echogram, 
where X is the horizontal scale (in pings, time, or distance) and Z is the range in metres. You 
can select for surface- or bottom-locked displays and for an X-axis in ping sequence, time, or 
distance units. Depending on the mode you choose, you can display every ping and every 
sample. You can choose the Z display range using the View options. Use the Pan view to 
display al1 the data for the channel. You can define the default display preferences used at 
channel opening with the Tools 1 Options menu. 

5. Use the right mouse button to increase the TVT (time-varied threshold) parameters, which set 
the threshold for the following pings up to the next TVT tuple. To add TVTs for the whole 
echogram or a portion of it, use the CH2 Insert-TVT tool. Select the tool and point on the 
echogram where you want to insert a TVT. Drag if you want to insert it for a portion of the 
echogram. You will then be asked for the parameters for the two TVTs you want to create, 
first for the left limit and then for the right limit. The defaults for the right limit are the 
parameters of the original TVT for this portion of the echogram. 

6. To zoom on the echogram, select the CH2 Rectangle tool, and point and drag to define a 
rectangle on the portion of the echogram you want to zoom. Then right-click and select the 
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Zoom-in operation. CH2 does not zoom on the displayed bitmap, as is usually done in most 
~indows95/98@ applications. Instead, CH2 rereads the data file in order to increase the data 
resolution in the new display zone. To go back to the previous display zone, right-click and 
select Previous zone. 

7. To edit or classi@ (label) portions of the echogram, use the various CH2 region tools to 
define regions on which you want to perform an operation. Double-click to close polygons or 
to end polylines. Use the Shift key to define other regions of the sarne type on which you 
want to perform the same operation. Then right-click to select the operation to perform. If 
you wish to perform the same operation on the same region(s) for other channels, you must 
first choose the option Project to other channels. For the Exclude operation, browse through 
the list to select the type of exclusion desired and provide the requested parameters. For the 
Classifi operation, use the Select button to define or select a Category and an optional 
Reason for the classification. The newly defined items are added to the corresponding two 
lists (that reside on the ~indows95/98@ registry of the PC in use). Note that the Bad data 
category is used by CH2 as a rnissing-data category and is considered as such by the 
echointegration algorithm. The operation is performed when you click on the OK button and 
the region(s) is (are) hatched using the pattern and colour that you have chosen in the 
Properties menu for the selected Category. If you then change the display mode (e.g., from 
surface-lock to bottom-lock), the region will be visible in tinted blend without the polygon to 
indicate that it is defined in the alternate reference mode. 

8. To automatically edit the detected bottom, use one of the following region tools: Whole 
echogram, Selected run(s), or Selected pings. Right-click and choose the Move bottom 
operation to change the detected bottom range by a positive or negative offset in metres. 
Choose the New bottom detect level operation (also available with the Rectangle and Below 
polyline regions) to move the bottom to the first sample range corresponding to the defined 
new level (in volts or dB), starting from the transducer face, the top of the rectangle, or the 
polyline. Use the constraint option to limit the changes of bottom ranges to a given window 
half-height around the present detected bottom. To modiQ the bottom range manually, use 
the manual Bottom sample or Bottom line tools. Click to select bottom echo samples, double- 
click to end the polyline, and right-click to perforrn the operation. Note that changing the 
detected bottom also changes the location of the previously classified regions in the bottom- 
lock mode since these regions refer to the bottom. 

9. To view, export, add, delete, or edit positions, use the CH2 tool Edit/add positions in ~xce l@.  
This sends the positions to an ~ x c e l @  worksheet (version ~icrosof t@ 0ffice97~) containing 
macros that generate graphs to check for position or time errors and that correct or filter 
positions. Click on the tool and the Send positions button to open ~ x c e l @  (if it is not already 
open) and to generate the worksheet. To add a position(s), insert a line(s) and fil1 in the CPU- 
time colurnns (A,B,C), the GPS-time columns (E,F,G), and the position colurnns (J,K; 
negative values for western longitudes and southern latitudes). To delete positions, you can 
either delete the corresponding lines or use the macros. Many macros are available through 
buttons above the worksheet. The All-graph macro generates a series of graphs on the graph 
page of the worksheet to check for position errors. The Current Position macro offers some 



possibilities to edit the position row on whch the pointer is located. The Speed Graph macro 
generates a graph of vesse1 speed on the data page of the worksheet. You can click (slowly to 
allow ~ x c e l "  to respond) on outlying points on that graph to directly access the Current 
Position macro to correct that position. If a new graph is computed, the original and edited 
(predicted) values are shown on the graph for comparison. Similarly, you can apply a moving 
average (Smooth rnacro) or a moving linear regression (Mobile-regression rnacro) to the 
whole time series. The original positions are updated with the predicted values using the 
Apply macro that copies the modifications in the CH2-sensitive columns mentioned above. 
When the position editing is done, retum to CH2 and click on the Retrieve positions button 
of the dialog box. An Edit position operation is then performed, new position tuples are 
created and corresponding edited positions are tagged as edited. This operation is added to 
the Undo list. 

10. To undo the last operation or series of operations, select the starting operation from which 
you want to undo the series in the CH2 Undo box. The series of operations will be undone 
and will be added to the Redo list. The Redo box is used the same way to redo the operations 
in the same sequence they were originally applied. The version 2.0 of CH2 does not include 
the possibility to undo or redo a single operation inserted in the list because of possible 
incompatibility with some subsequent operations in the following series. 

11. To Save the file with the editinglclassification operations and the index generated by CH2, 
use the File / Save as menu to create an edited HAC file. The editinglclassification HAC 
tuples will be added to the original HAC tuples, thus preserving the original data in 
accordance with the NHP-DAT approach. CH2 does not allow writing over the original HAC 
file. 

12. To echointegrate one or several channels per Echo category, click on the CH2 
Echointegration tool. The General tab of the dialog box is for defining the output file narne(s) 
and location, the type of echointegration results, the echo category(ies), the minimum 
sampled fraction of grid ce11 to echointegrate, and for changing the sound speed, if needed. 
You can edit the default root name for your *.hei file(s) and the default directory. The 
Channel number and the Block number will be added to the root name. Choose the type of 
echointegration result you want to compute, which is either the area backscattering 
coefficient, sa, per depth strata (unitless, m2 per m2, linear, see Mac Lennan and Femandez 
2000) or the volume backscattering coefficient MVBS (s,, linear units) per depth strata (m2 
per m3, ibid.). Choose the Echo category(ies) for which you want to get the echointegration 
results. The displayed categories come from the list in the ~indows95198" registry of the PC 
and an eventual loaded *.eip file. Note that when Echo categories overlap on the echogram, 
the overlapping echoes are integrated in every Echo category, unless it is the Bad data 
category, which is handled as missing data. The Unclassified category corresponds to al1 
echoes that have not been included in any Echo category, whether the categories were active 
or not. Specify the minimum fraction (in %) of the echointegration grid ce11 that must have 
been sampled to compute echointegration results. Unsampled fractions result from the bottom 
(or minimum sampled depth for bottom-locked depth strata) intruding into the grid ce11 or 
because portions of the grid ce11 have been classified as Bad data. This Minimum sampled 
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fraction of grid ce11 to echointegrate does not apply for the Whole sampled water column 
depth strata. Note that the regions classified with the Exclude operation have their echo 
values set to zero (which is different from Bad data regions). Finally, change the average 
sound speed used at acquisition if required. 

The Channel tab of the dialog box is for selecting the channel(s) to integrate and for 
changing their default parameters for computing the echointegration results. Al1 valid 
echointegration channels are selected by default. Uncheck the channel(s) you want to exclude 
from the echointegration task. Edit the channels' default parameters if needed. 

The Step tab is for defining the horizontal axis of the echointegration grid and the series 
of Runs to group in separate Blocks to compute the echointegration results. Define the series 
of Runs (if the file contains more than one Run) to concatenate into a Block for which you 
want to report the results in a separate *.hei file. Determine the horizontal step interval for the 
echointegration results in either ping, time, or distance units. If you choose the time option, 
you are allowed to align the steps on a given minute:second of the hour. This option is 
required to properly align the results for further multi-echosounder or multi-channel 
processing of the echointegration results. CH2 automatically corrects for the drift of the PC 
clock relative to the GPS time, up to an offset of 30 min. The echointegration output *.hei 
ASCIi file(s) includes Cartesian CO-ordinates from a Lambert projection, which are needed 
for processing the echointegration data in a geostatistical framework or simply to produce 
non-deformed spatial plots. You must define the origin CO-ordinates and the optimal domain 
(between the two reference latitudes) of the Lambert projection. 

The Depth strata tab is for defining the series of surface- andlor bottom-locked depth 
strata for which you want echointegration results. The various series of depth strata are 
allowed to overlap. A Whole sampled water column stratum is automatically output in al1 
*.hei files by CH2. Note that the surface-locked depth strata are defined according to depth 
and not range. In computing echointegration results, if necessw, the stratum starting depth is 
automatically adjusted to the minimum sampled depth for the corresponding channel (sum of 
Transducer installation depth and the Surface blanking distance). The OK button copies the 
parameter values to the memory so that they will be displayed by the dialog box the next time 
it is called instead of the default values. The setting for the echointegration parameters can be 
saved in a file (*.eip) for recall. CH2 echointegrates from the minimum sampled depth down 
to the detected bottom sample, and vice-versa for the bottom-locked depth strata. Bottom-lost 
pings are ignored unless the bottom is redefined during editing. Finally, click on the Integrate 
button to produce the *.hei file(s). The *.hei file format is given in the supplied HEI- 
format-ver 1.1 .xls file and in Annex 1. 

13. Consult the on-line help or subsequent chapters of this user's manual for more information. 
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4. OVERVIEW AND GENERAL FUNCTIONS 

This chapter outlines the general aspects of operating CH2, a ~indows95/98@ C++ 
application. CH2 is an MD1 (Multiple Document Interface) application, which means that the 
software can handle more than one HAC file at the same time. Here, a document means one of 
the three types of data sources handled by the HAC data acquisition software, CHI, or other 
applications producing standard HAC version 1.0 files using the sarne tuple types that CH1 uses. 
These sources are: the Biosonics-like analog echosounders, Biosonics- 17 1 multiplexed signals 
played back from tapes, and the digital Simrad EK500 type. Therefore, CH2 can simultaneously 
visualise and edit HAC files acquired from many echosounders. An echosounder can have many 
channels representing different frequencies, different bearns, or other information (Figure 4-1.). 
CH2 can then edit, classify, and echointegrate separately on the various channels for a given 
echosounder or on al1 channels simultaneously. The echointegration is performed per Echo 
category at the user's request. The present version 2.0 includes the basic facilities presented in 
this manual to handle the multi-channel data. Further versions should include more elaborated 
functions and algorithms to combine the information from the various channels, to exploit the 
possibilities of multi-frequency acoustics and multi- or composite-beam (dual- or split-beams) 
data in quantifying and qualifying the biomass and the distribution of the marine life echoing the 
transrnitted sound. 



A) CHI, single beatn, single frcquency. B) C H ,  d~ial-beatii, single frcqueilcy. 

C) CHI, split-beam, single frequency. D) CHI, aplit-bcam and dual beain, two 
fsequencies. 

Figure 4- 1. Exaiilples of multi-chaiincl, riiiilti-ecliosouncles configuratioiis haiidled by CH1 
and CH2. 

- 
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At the start of CH2, the following wi~idow with a gridded magnifying glass oii a 3-D 
parcel of ocean (Figure 4-2.) is displayed for 10 secoiids. It disappears oii a click to display the 
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Figure 4-2. CH2 opening window. 

Operators' list dialog box (Figure 
4-3 .). CH2 tags al1 
editiiiglclassification operütioiis 
perfonned on the data by a user's 
name. This attribute can be used 
iii ft~ture exan~iilation and 
processiiig of the edited HAC 
files. The operators' list can be 
generated or edited froni that 
dialog box, or via the Edit 1 
Operators' list meiiu. This list 
resides on the ~iiidows95198' 
registiy of the PC, in the present 
versioii of CH2. As iildicated, 
one operator must be activated to 
operate CH2. 

Figure 4-3. CH2 operators' list dialog box. 
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After having defined and/or selected an operator by double-clicking on the name or by 
using the Select and OK buttons, the main CH2 window opens. The various functions of the 
CH2 menus are summarised in Figure 4-4. The File and Windows menus are quite standard but 
the other menus have specific CH2 functions. Most of them can be accessed more rapidly by a 
right-click on the mouse or from the tool icons. 

Original or edited HAC file(s) are opened from the File menu. Figure 4-4 shows the 
CH2 display when three channels of an EK500 HAC file are opened. The characteristics of the 
channel and of the echosounder can be obtained from a right-click on the mouse (Figure 4-5). 
Other frequently used CH2 functions can also be accessed quickly from the mouse right button. 
The status bar indicates local information at the pointer position for the active echograrn. Each 
echogram displays its specific channel data in its own units (volts, Sv, TS, etc.). Depending on 
the echogram window size, al1 pings andlor echo samples are not always visible because of the 
limited range of pixels displayed by the window. When a zoom is performed on one channel 
(using the Rectangle and zoom tool followed by a right-click selection, Figure 4-6), CH2 does 
not zoom on the bitmap, as is usually done in ~indows95198" applications. CH2 loads into the 
window al1 the new pings and echo samples that the window is now able to display for the new 



zoomed region (e.g., Figure 4-6). The same is true when the size of a window is changed. CH2 
always displays the maximum data that the window pixels allow. For large files, this sometimes 
requires the reading of HAC data from disk, which is not always instantaneous on slow PCs. The 
echograms can be tiled or cascaded from the CH2 Window menu. 

Figure 4-5. CH2 functions directly accessible from a right-click on the mouse and the 
general visualisation preference dialog box. 

The data can be visualised along three types of horizontal axes: ping sequence, time, or 
distance. Vertically, they can be visualised as referenced to the transducer depth, in surface-lock 
mode, or to the (original or edited) detected bottom, in bottom-lock mode. The user can 
detemine a view range interval or obtain a full view of the echogram from the Pan view option 
of the View menu or the mouse right button short cuts. The user also defines the palette used to 
display the echo sample values. Al1 these viewing characteristics are channel-specific properties 
that the user can change for any channel from the View 1 Properties menu, which can be accessed 
from the mouse right button (Figure 4-5), the user can define the default channel display settings 
used by CH2. The echogram display zone that preceded the active one is always preserved in 
CH2 memory and can be recalled by the selection of the Previous zone option from a right-click 
on the mouse. 
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Figure 4-6. Example of a CH2 zoom on the data enclosed in the selected rectangle. Note 
the higher resolution achieved by bringing in new data and that scroll bars 
have appeared on the sides of the window, indicating a zoomed echogram. 

CH2 editing/classification functions can be classed into two categories. Tool tips that are 
displayed when the pointer is over each tool identify these functions. First, three general editing 
functions serve to editfadd TVT(s) or positions and to manually define the bottom with the 
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mouse (Figure 4-7). Second, other editing/classification functions are applied to parts of the 
echograrn(s) that are defined by several region-drawing tools. This is the basic CH2 echograrn 
editingklassification approach. First define a region, over one or many channels simultaneously, 
and then apply the editing/classification operation on this region using the tools. A region can be 
as small as a single echo sample or a single ping, or as large as the whole echogram. There are 
eight tools to define a region on the echogram(s) (Figure 4-7). By selecting one of these, a region 
is defined with the mouse and can be projected to the other channels by a right-click option, 
before applying the editingiclassification operation from a second right-click. 

Two types of operations are cornmon to al1 region types (c.f. Figure 8-1). They are the 
classification (labelling) of the region as a particular Echo category, such as its taxonomic 
identification or its labelling as bad data, and the exclusion of the echo samples (values set to 

Figure 4-7. CH2 editingiclassification tools, distance measuring tool, and echointegratio 
tool. Example shows the Runs portions of an echogram or a HAC file and th 
use of the Ellipse region tool to define a regio 
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zero) from the region. Other operations are associated with certain region types only. These are 
the bottom editing operations, which are exclusive to the region types Whole echogram, Selected 
mn(s), Selected ping(s), and Below polyline, because the detected bottom is certain to be 
included in these region types, contrary to the other region types. Another special operation, the 
Zoom in, is exclusive to the Rectangle region type. The regions can be defined in either the 
surface-lock or the bottom-lock modes and they are tagged with the display mode in use at their 
creation. Their definition vertices then refer to the surface or to the detected bottom (original or 
edited) respectively. The selected echo samples of the edited/classified regions are painted in 
tinted false colour to localise them. However, the regions are visible only when the 
corresponding Echo category is active (see section 6.4, Edit / Echo category menu). When the 
display mode is the same as their creation mode, an additional mask corresponding to the region 
shape is added. Then, when pointing on a region shape, the pointer is changed to a cross and a 
magniQing glass, which indicates that the characteristics of the operation can be accessed from 
the mouse right button. Subsequent versions of CH2 will have the additional option to edit the 
operation. 

HAC files are edited or classified to identify unwanted data, to rectify imprecisions, 
namely in the bottom detection and vesse1 position, and to partition the echoes into distinct 
categories that could be used to produce separate echointegration estimates. The basic philosophy 
of CH2 is to incorporate these operations in the HAC files while preserving the integrity of the 
raw data. This is done by defining new tuples of the HAC standard data format (Simard et al. 
1997) containing the parameters of the editing/classification operations. When the user defines an 
operation, CH2 applies the operation to the data of the selected channels of the active HAC file, 
and creates an edition or classification tuple in the PC memory. At the same time an operation is 
added to the CH2 operation list and Undo list. When the HAC data file is saved, the new 
editinghlassification tuples are appended to the original raw data to create an edited HAC data 
file. This way no information is removed from the original data, in accordance with the CH* 
philosophy to acquire, archive, and preserve multi-echosounder, multi-channel acoustic data 
under a standard data format. The next version of CH2 will have the additional option of only 
saving the data retained after al1 the operations are applied, in order to reduce the size of the 
HAC files and therefore the amount of data to be handled by specific applications. When an 
edited HAC file is loaded by CH2, the editing/classification operations are applied in the same 
order that they were created. The data is therefore presented to the user in the same state as it was 
at the end of the last editing session. To see a previous editing state, the editing/classification 
operations can be undone using CH2's full Undo capability. Inversely the undone operations can 
be redone with the Redo function. The Undo 1 Redo functions can be used anytime while editing. 
The present version of CH2 can undo the 1 s t  operation or a selected operation with al1 the 
subsequent ones in the Operation list. It cannot undo a single operation imbedded in the 
Operation list, because this operation could be a prerequisite for subsequent operations in the list. 



Figure 4-8. Example of editinglclassifying an echogram with CH2 tools and the resulting 
echogram display, The HAC data file is from the vertical beam of a 202 kHz IOS 
experimental sonar sainpled without any threshold and withoiit bottom detection. First, the 
bottom is added (black line above the strong bottom echo) using the Manual bottom tool. 
Then a her-ring school is delimited and classified with the Polygon region in suiface-lock 
mode and represented with a hatched white mask. The visualisation mode was then 
changed to bottorn-lock and the Rectangle tool was used to exclude the echo samples 
(values put to zero) from a region in the iight part of the echogram above the bottom (the 
white pamllelogmm). The Ellipse tool was used in this visiialisation mode to classify a 
region as herr-ing above this excluded region. Switching back to the surface-lock mode, we 
see that the (deforined) elliptic herring-classified region does not Wear a hatched rnask, 
contrary to the other hei~ing-classified region, but is only visible by the colour change of 
the selected echo samples. This indicates that the elliptical region was deiïned in bottom- 
lock mode and sefers to the edited bottoin. Similarly, the rectangle where the echo samples 
have been excluded is deformed in a parallelogram following the bottom slope and does 
not have a hatchecl mask. Finally, the TVT tool is used over a range of pings to threshold 
out the echo sarnples lower than the noise floor as an example of the application of this 
tool to only retain the significant clüta. Note that two TVT icons mark the location of the 
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An example of the use of CH2 editing/classification functions to process a HAC file 
containing a large herring school is presented in Figure 4-8. The data were acquired with a 202 
kHz IOS experimental sonar for the vertical beam without any threshold, and then translated to 
the HAC standard data format. The bottom was sloping from ranges 154 to 176 m but was not 
detected at acquisition. To process the file, the bottom is first added using the Manual bottom 

Figure 4-9. Example of editing positions with CH2 via Excel. After having sent the positions 
to Excel using the Edit/add position via Excel tool, a speed graph is built with the 
SpeedGraph rnacro in step 1. The graph shows abnormally high frequency speed 
fluctuations. In step 2, the examination of other graphs (e.g. with the AllGraph 
rnacro) reveals that the latitude did not change as a monotone smooth function but 
as a step function. This is indicative of a lack of precision in the latitude data. To 
correct the positions, a mobile regression using a half-window of four neighbours 
is computed with the Mobile Regression rnacro in step 3. In step 4, the Apply 
macro is used to replace the original positions with the predicted positions from 
the mobile regression. The corrected positions are then retrieved by returning to 
CH2 and clicking on the Retrieve positions button of the Edit/add position via 
Excel tool. 



tool. Here it is placed 2-3 m above the probable bottom range to increase its visibility. New 
Edition tuples are added to define the new bottom at every ping intersected by the polyline drawn 
from the Manual bottom tool and none of the original data is changed. A New bottom from 
polyline operation is added to the Operation and Undo lists. Then the quality of the position data 
is inspected with the Editlzdd position in Excel tool (Figure 4-9) (see section 8.5). The position 
data are sent to Excel and the ship speed is plotted against the position sequence number. The 
ship speed fluctuates abnormally, which reveals that there is imprecision in the position data. An 
examination of the various graphs indicates that the latitude data was imprecise, likely due to the 
truncation of CO-ordinate decimals at acquisition. The position data thus require a correction. 
This is achieved by filtering the position data with a mobile linear regression on a window of 
nine positions. The new positions are then retrieved by CH2. This adds new Position tuples and 
Edition tuples defining which original Position tuples were updated. Again, none of the original 
data is changed and a new Edit position operation is added to the Operation and Undo lists. 

Once the basic spaceltime reference data are validated andlor corrected, the Polygon tool 
is used to define a region encompassing the herring school in the example of Figure 4-8. A 
double-click closes the polygon and the selected echo samples are indicated by inverse-video. 
Then the mouse right button offers three possible operations for this selected region: Classify, 
Exclude, or Project to other channels. The third option allows the projection of the region(s) to 
other channels in the file if any exist. By selecting Classifj, a dialog box opens to select an Echo 
category from the Echo category list. New Echo categories can be added and their display 
properties defined. Herring is added with a white cross-hatched pattern. The hatched polygon 
shape is drawn over the selected echo samples, which are whitened by a blend of their displayed 
colour and the polygon colour. A Classification tuple is added to define the newly classified 
region of the echogram tagged with its Echo category attributes. A Classify [Herring] operation is 
added to the operation and undo lists. 

The next step rnight be to echointegrate for herring using the Echointegration tool, and 
selecting only the Echo category "Herring" (see section 8.6). The results of the echointegration 
over the defined X by Z echointegration grid will be output in a *. hei ASCII file (format defined 
in Annex 1). If the user wants to simultaneously compute the echointegration results for the rest 
of the unclassified part of the echogram, he would also select (check box) the automatic Echo 
category "Unclassified" for echointegration. Similarly, if other regions of the echograrn would 
have been classified with other Echo categories, the CH2 Echointegration tool could 
simultaneously compute the results for each category. Moreover, it could compute the 
echointegration results for al1 Channels of the HAC data file at the same time (c.f. Figure 8-23), 
with or without Echointegration thresholds. 

Before closing the HAC file, the editing operations can be saved using the CH2 file 
menu. CH2 does not allow ovenvriting an original HAC file, for security reasons. The Save as.. . 
option must be used to Save an edited HAC file for the first time. The Edition, Classification, and 
Operator tuples are appended to the original tuples, a tuple declares the file as edited and an 
Index tuple is added before the new End of file tuple. Thus the original data are preserved and the 
new information added during the CH2 editing session is attached to the file in the standard 
HAC format. When an edited file is loaded by CH2, the operations are applied to the original 
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4.1 Data processing recomrnendations 

The philosophy behind CH2 was to give the user the flexibility to analyse a large amount 
of high-resolution hydroacoustic data in a quick and user-friendly manner. This section was 
designed to guide users through the basic data processing steps to hopefully reduce time wasted 
redoing data treatment operations because essential processing steps were missed or completed 
out of order. It is presumed that users will develop their own procedures for data analysis, 
depending upon their preferences, experience, and, of course, data quality. In this section, we 
wish to outline the various analysis steps to be taken to produce species-by-species 
echointegration results from HAC hydroacoustic data files as well as the recornrnended order for 
these operations. The order of these operations will become important if one wishes to undo and 
redo certain operations, for instance species classifications, without losing the results of other 
rather time consuming procedures, such as bottom redefinition and the editing of electronic 
interference. 

Checking Errors upon Opening a Data File: 

Errors often appear in acoustic data files due to various electronic and operator mistakes 
or malfunctions. Often these errors will affect echointegration results and the interpretation of 
data by CH2. It is therefore essential to correct these errors before proceeding with further data 
treatment and analyses. When an original HAC file is loaded, CH2 checks for HAC file integrity 
and builds an index. It also checks for a number of known data errors when the file checking 
mode is activated (File 1 File checking options.. ., section 5.9). If data errors are found, a message 
will be displayed by CH2, sometimes asking the user for a decision on subsequent steps. An 
ASCII log file will be created that sumrnarises the erroneous data fields. Some of these file errors 
may not be significant and you may wish to ignore the error and proceed with the file opening. 
Others, such as errors in ping sequence or time stamp can severely impact some CH2 operations, 
namely echointegration. Therefore, the first step of data processing is to check for and correct 
these errors if they occur. Some tools are available within CH2 and the HAC-trafic utility 
application to correct most problems occurring in HAC files collected by earlier versions of 
CHI, while this application was still in its beta phase. In addition, if the user wishes to adjust the 
time within a file by a fixed amount, e.g., to change the time from GMT to local time, the time 
can be adjusted for the entire file in HAC-Trafic. This should be done before initiating any 
editing with CH2. 

Time Errors: 

We have identified a number of errors in the time stamps of various tuples in HAC files 
collected with earlier versions of CHI.  These errors arose mainly from the use of an imprecise 
method for assigning time to certain tuples, and from not using the same method for al1 tuples. 
This has been corrected in CH1 (ver. 2.1); however data files collected with earlier versions may 
need to be rectified. In addition, other time errors can arise if the computer clock (time, date, and 
time zone) was not properly set. This is easy to do on a ship given that some users prefer GMT 
and others local time, which is not necessarily the ship's local time, nor the office time, which is 



often the default time on the computer, etc. Since CH2 uses the time stamp to reference various 
tuples, it is important to identify and correct al1 time errors before any other operations are 
performed on a HAC file. 

Position Errors: 

Among the most common errors are position errors, caused either by bad data 
communications, bad data interpretation, or by problems at the source, e.g., GPS drift, signal 
interference or data imprecision. These errors are easy to visualise by tracing the cruise track on a 
chart or graph. Position data can be exported for viewing in software of the user's choice through 
the File / Export Position data feature (section 5.5). However, it is recommended to use the Tools 
/ Editladd positions via Excel tool of CH2 to visualise and edit position errors (section 8.5). 
Several automatic and manual tools are available in this module to identi@ and correct erroneous 
positions, although a graph of vesse1 speed is often the best for judging the quality of the position 
data. Once an erroneous position is identified, the user can choose among various options such 
as: (1) manually correcting the position when the error is obvious, e.g., 48 52.97 instead of 58 
52.97, (2) interpolating or extrapolating what the position should have been using a running 
average or a running regression, or (3) simply elirninating the position. 

Redefining the Detected Bottom: 

When echoes of interest are distributed near the bottom, it is of utmost importance to 
exclude the bottom signal from data analysis. The definition of the detected bottom is often the 
most delicate task to be performed because one must not leave any "rocks" in the region to be 
integrated. However, when significant amounts of fish are found close to bottom, one must not 
be too conservative either, by elirninating legitimate fish biomass. There are various manual and 
automatic tools in CH2 to redefine the bottom boundary (Tools / Manual Bottom; Tools / 
Selected Runs (or Pings) / Move bottom, etc. - Chapter 8). Once this has been accomplished, the 
user should review the bottom definition by zooming on the bottom signal and scrolling dong 
the data file to ensure that no bottom signal is present in a zone to be integrated. 

It is important to define the bottom before defining any classification regions in Bottom- 
lock mode. In this mode, the regions are defined in relation to the detected bottom. Therefore, if a 
bottom editing operation changes the detected bottom beneath a region defined in bottom-lock 
mode, the vertices defining the region are also changed, as are al1 the classified echo samples. 

Changing Signal Threshold: 

We may decide that the TVT was too low during data acquisition and should be raised to 
elirninate low level background noise or low amplitude echoes, such as plankton. In this case, the 
user can either edit the existing TVT (Edit 1 TVT, section 6.5), add a new TVT (Tools / Insert 
TVT ..., section 8.4) to a selected region or specify an increase in the signal threshold for 
echointegration (Tools / Echointegration 1 Channels / Echointegration threshold (Sv) - section 
8.6.2) to a selected region. 
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Noise Removal: 

It is often useful to elirninate regions that are not considered interesting, such as those 
which contain significant external noise above threshold, e.g., from trawling activity, electronic 
interference, or where the system may have malfunctioned. These regions should be defined 
using the various region selection tools (Chapter 8) and either excluded or classified as bad data. 
Note: If a region is excluded, the value of the samples within this region will be set to O and will 
be included in the echointegration of the region. If, however, the region is classified as bad data, 
the samples will be excluded from the echointegration results from this region, i.e., nul1 data. 

Modification of Parameter Values: 

Often a user may wish to correct various stored parameters that were used during data 
analysis. For example, it may be deterrnined after the fact that certain echosounder or channel 
parameters were not correct during data acquisition and should be adjusted for data analysis, e.g. 
sound speed, transducer depth, absorption coefficient, transducer gain. Most of these sensitive 
parameters can be updated during echointegration (Tools / Echointegration / Channels tab, 
section 8.6.2). 

Classification of Echoes: 

At this point, we can identifj and label the various regions of interest, i.e., species and 
species groups. Ideally, identifying the regions should be done as soon as possible after the 
mission, or even during the mission, when the conditions under which the data were collected are 
still fresh in Our minds. We therefore select the various echo aggregations with the various 
region-drawing tools and classify these regions into species or species groups (section 8.1). It 
must be kept in mind that each echo category will have a separate echointegration table, therefore 
regions should be classified to identify species mixes and sizes that reflect the corresponding 
information from the trawl data. For example, regions where trawling showed concentrations of 
only herring could be classified as "Herring" while other regions where trawling showed a 
mixture of herring and cod could be classified as "Herring/Cod". CH2 can therefore produce 
separate echointegration tables for these two classes, and separate TS and species-mix 
proportions can be applied to the echointegration results for biomass estimation. 

,:.:y 
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5. FILE MENU 

The File configuration menu offers the following comrnands: 

Open 
Close 
Save 
Save as... 
Export position data 
Print 
Print preview 
Print setup 
File checking 
options.. . 
List of recent files 
Exit 

Opens a HAC file. 
Closes the active HAC file. 
Saves the HAC file under the cunent file name if it is not an original file. 
Saves the HAC file under a new file narne. 
Exports position data under the *.bna or *.txt formats. 
Prints a copy of the active echogram. 
Previews the print output. 
Configures the printer to print the echogram. 
Configures the options to check HAC files for enors at opening. 

Opens a recently opened HAC file. 
Closes CH2. 

5.1 File / Open 

--This dialog bo? is used to browse through your disks to select a previously saved HAC 
file that you want to process with CH2. If this file is one of the last nine HAC files used by CH2, 
select the file from the list that is displayed when you click on the File menu. 



Once you have chosen a file, a dialog box will be displayed while the file is read and 
checked for errors, and an index is generated if it is not a CH2-edited HAC file, which already 
has an index. If the file contains errors or lacks certain significant data, the user is asked if he 
wants to continue with the opening of this file. Then a new dialog box (Figure 5-2) displays the 
channzls the file contains, and the characteristics of the channel you select with the mouse. By 
default, the first channel of the list is selected. Use the Shift key to select several channels or the 
Al1 channels radio button to open al1 channels of this HAC file. Then click on the View button to 
display the selected channel(s). 

Figure 5-2. File 1 Open, View channels dialog box. 

5.2 File 1 Close 

This option closes the active HAC file with al1 its attached channel echogram windows. 
Al1 the other opened HAC files will remain open, and one of them will become the CH2 active 
HAC file. Warning: Your editing/classification operations,for this file will be lost if you do not 
Save them before closing the file. The usual file closing warning will remind you to do so. If you 
only want to close the active channel window, use the standard ~indows95/98@ window-closing 
button (X) at the right corner of the window. 



5.3 File / Save 

This option saves the active HAC file with your editing/classification operations. CH2 
does not allow ovenvriting the original HAC file name. Use the Save as.. . option if your active 
file is an original HAC file. 

5.4 File / Save as.. . 
This saves the active HAC file with the editing/classification operations under a new 

name (required) if it is an original HAC file that was edited for the first time. The same name can 
be used for edited HAC files. 

5.5 File / Export positions data 

This option (Figure 5-3) exports the GPS position data in comma separated ASCII text 
files (*.txt) or in Golden Software *.bna format to use directly with surfer@ or ~ a ~ ~ i e w e r @  to 
plot the data locations on a map. 

5.6 File / Print 

This option prints the echogram bitmap view of the active channel window with an 
identification heading. This is a rough "quick-and-dirty" printing of the echogram. The usual 
Windows clipboard features can also be used advantageously to export the active echogram 
bitmap ( Alt-Print Screen) towards various bitmap editing and printing applications such as 
Windows ~ a i n t @  or   hot os ho^@. 



5.7 File / Print preview 

This option previews the printed output of the active echogram window with the 
identification heading. 

5.8 File / Print setup 

This option configures the printer to print the bitmap of the active echogram window. 

5.9 File / File checking options.. . 
This option configures special file 

checking options when a HAC file is loaded. 
It mainly concerns old HAC data files 
collected during the development of the CH* 
suite, which contain certain errors that can be 
corrected individually by CH2 or in batch 
mode (several files) by the HAC-trafic utiljty. 
The same File checking options can be 
configured from the File menu of HAC-trafic 
without opening any file. Selecting this 
option from the CH2 File menu opens the 
corresponding check-boxes (Figure 5-4). The 
File Checkinrr O~tions Manager check-box 

Signature validation 
Edition tuple integrity 
Ping order 
Time synchronisation ( second vs decimal ] 
Time Variation [ warning ) 
Pings within run limits 
Old TVT equation used [ warning ] 

activates or deactivates al1 the options. Seven 1 
types 
activa 

of known errors can be check 
~ting the check-boxes within 

:ed for by 
the File 

Checking options dialog box. They are 
described in section 11 Error messages and 
troubleshooting. If any of the selected error 
types are found, a critical error message will 
be displayed (e.g., Figure 5-5) except for the 
Time Variation plugin, which will only 
trigger a warning. The message indicates the name of the ASCII-text log file containing 
information on the error and the HAC file properties. The option to correct the error is offered. 
The file loading will abort if the user chooses to not correct a critical error. Alternatively, the 
error log file and the corrected HAC file will be written to the Working directory selected in the 
File Checking Options dialog box. The corrected HAC file will have the same root name as the 
original HAC file plus the " c o r "  characters (e.g., C13bil23cor.hac). 

It is recommended to deactivate the File checking options if you are not working with old 
HAC data files, but to activate them if CH2 has difficulties opening or processing certain files. If 
the File checking options are deactivated, standard CH2 warning messages will nevertheless be 
displayed if critical errors are found while the file was read. In the case of critical errors, file 
loading will abort. 



Figure 5-5. Message displayed when an error in Time 
synchronisation (second vs decimal) is found 
in a HAC file by the File / File checking 

5.10 File 1 List of recent files 

This is the usual direct access to the list of recent files, which can contain up to nine files. 
Files are removed from the list if their opening is aborted, which could result, for exarnple, from 
a move or erase of the file from the directory or from a file name change. 

5.11 File 1 Exit 

This option closes CH2 and al1 the opened HAC files. You can also exit CH2 using the 
standard ~indows95/98@ window-closing button. 
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EDIT MENU 

The Edit menu offers the following commands: 

Palette Edits the active channel palette. 
Operators' list.. . Edits the operators' list, adds or deletes operators from the list. 
Operation reason list.. . Edits the operation reason list, adds or deletes reasons from the list. 
Echo category list.. . Edits the Echo category list and their properties, and 

activates/deactivates the categories. 
TVT(s) Calls the Edit TVT(s) dialog box to edit the TVT(s) the file 

contains. 

CH2 works with Operator, Operation reason, and Echo category lists that are regularly 
called when perfonning editing and classifications on HAC data. These lists reside in the 
~indows95/98@ registry of the PC in this version of CH2. They can be viewed and edited with 
the Edit menu. The Edit menu also serves to view and edit two properties of the active channel, 
the Palette and the TVT(s). These latter functions can also be accessed through the mouse right 
button. Double-clicking on the Palette bar is a shortcut to the Palette editor. 

6.1 Edit / Palette 

The Palette editor serves to define, store, and load palettes associated with channels or to 
define defaults for various data types. It can be accessed through a double-click on the Palette 
bar, the Edit / Palette menu and the right-click menu. The palette is applied over a given range of 
data values, detennined in the Min. and Max. fields of the Palette editor dialog box (Figure 6-1). 
An option can be selected to mask the colours at both ends of the palette by another colour, 
below and above specified data-limit values, which are entered in the corresponding fields. The 
colours are chosen by double-clicking on the respective Above and Below buttons. The Limit 
colour Show button applies the given limits to the palette bar. This palette limit option is very 
useful to mask data values below or above specific thresholds without changing the range of 
values (i.e., the colour scaling) to which the active palette applies. A special colour can be 
assigned to the detected bottom sample through the Bottom button. The defined palette can be 
saved and loaded using the Save and Load buttons. The binary Palette files have the extension 
*.pal. CH2 associates a default palette to each of the following data types: volts, Sv, TS and al1 
others. These default palettes are configured in the Tools / Options menu (see section 8.7). The 
Set as default button replaces the default palette associated with the current data type with the 
present palette. Warning: The default palettes are stored in the ~indows95/98@ registry of the 
PC. Therefore, when CH2 is installed on a new PC the default palettes must be reconfigured, 
which can be easily done by loading a previously saved *.pal palette file for each data type. 



Palettes can be defined in three different ways: a parameter model, a colour gradient 
between two given colours, and an advanced gradient(s) mode. Thcse three palette definition 
methods are detailed below. 

Selectirig the Parameters radio button of the Definition inethod group chooses this mode. 
In this palette definition mode, a continuous circular colour gradient from blue to green to orange 
10 sed to magenta and back to bliie is generated from the combination of the three RGB piimary 
colours (Figiire 6-2). The palette is defined by thsec parameters: an Offset, a Span, and an 
Expoiient parameter. The Span parameter determines the fraction of the colour cycle that is 

Figure 6-1. To eclit the palette for the active eçhogsam, access the Palette editor dialog box 
through the Edit menu, the right-click menu, or by double-clicking on the palette 
bar. Palettes are associated with the data type. They can be saved and recalled in 
ASCII *.pal files. HAC file channels x e  loaded with CH2 default palettes, 
which can be determined by the uses. The advanced palette is displayed in Figure 
6-3. 



Data vnlucs 

Max. 

Figure 6-2. Workiiig of tlie Parameter palettes and examples witli different pammeter 
settings. The fuI1 coloiir gradient available is displayed on tlie Palette bar wheii 
the Offset is O and the Spm is 1 .0 (top Palette bar). This gradient has blue at 
botli ends, wliicli givcs a circular colour cycle. For dekining a warm palette, as 
the one showri on the Y axis, the blue ai tiigli values is eliniinated in the 
second Palette bar by usirig only 80% of the colour cycle witli a Span of 0.8. 
'i'lie use of a ~iegative Offset of-0.1 iii the thisd palette briiigs niore cold blue ai 
low values and removes sonie magenta at liigh vcilues, by shifting tlie 80% 
selection by -10% on the coloiir cycle. In the fourth palette, the selected 

tlie beginniig of tlie palelte to 25% of tlie coloor cycle. Negalive values are aiiowed. They can be 
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iised to bring tlie blue coloiir of the encl ol' the coloiir cycle at tlic paletle start for gerlerriting a 
continuous warni palette (e.g., Figiire 6-2). 'The Exponent p;ii.ameter deterinines how the selected 
coloul- band will be allocalcd to thc data values. An exponetit of 1.0 gives a lincar allocation; the 
coloiirs are liriearly attribiited to the clata valiies. Othcr Exponent values produce exponential 
allocations according to a riiriction Y x(""~'<"'""') , whcre Y ar- tlie colours and X are the data 
(sce Figiire 6-2). Thc Show button of the Definition inclliod gi.oiip displiiys the configiii.ed 
palelte. The paletle can bc convertccl io a grey scalc by selccling the Black & Whitc option. The 

Fig~~re 6-3. The advancecl step pttlelee is accesscd ii.om Ihs ">>" bution of the Definilion 
meeliosi pcirameter group of the Palette cditor dialog box. The 256 colour table 
is displayed, The data value cosresponding to one colour ce11 is obfaincd by 
pointing on the ceIl and readirig thc fields in tlie top right cori~cr. A search for 
tlie coloiir cell cosrcsponding to a given data value can be performed with the 
Se~irch button arid the Val, field. Any of the 256 çolours can be changed by 
double-clicking on it. Colours can be copicd and pastecl Srom one ccll to 
aiiotker. Any colour cell can becori~e a icrlous node (ourlined in red) by 
selecting it, t'rien cliçking on the Node/Add button, Colours tiettve- ,n two 
successive nocles are linearly inlei-polated, Thc changes made can he undone 
step by step with the Unclo button. 
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Invert option inverts the palette. To view the data value assigned to each colour, click on the 
">>" button of the Definition method group to open the generated 256-color table. Then point on 
any colour ce11 or on the vertical colour bar to display its data value in the upper right corner. 

6.1.2 Colour table method 

Selecting the Colour table radio button of the Definition method group selects this mode. 
A palette is then generated as a gradient between two colours that are selected from the Min. and 
Max. buttons. The number of steps for the palette, from 2 to 256, is given in the Step field. 

6.1.3 Advanced mode 

The Advanced mode is selected by clicking on the ">>" button, which adds a new panel 
to the dialog box (Figure 6-3). This panel contains the 256-colour table corresponding to the 
vertical colour scale displayed on the left, and buttons and fields used to define a custom palette. 
The default colour table displays the 256-colour series between the colour ce11 index O and the 
colour ce11 index 255. These two lirnit colour cells are called the colour "nodes" of the gradient. 
Colour indices are displayed in the Interpolation group fields (top right) when pointing on a 
colour ce11 of the table. The colour of any ce11 of the table can be changed by double-clicking on 
it. The Copy and Paste buttons of the Selection group are used to copy the colour of one ce11 to 
another ce11 (as a shortcut, simply click and drag from one ce11 to the other one). The data value 
corresponding to one colour ce11 is obtained by pointing on the ce11 and reading the Val. field in 
the top right-hand corner. A search for the colour ce11 corresponding to a given data value can be 
performed by typing the value in the Val. field and clicking the Search button of the Interpolation 
group. The colour ce11 found is indicated by a white contour. Any colour ce11 can become a 
colour node (outlined in red) by selecting it, then clicking on the Node/Add button. Colours 
between two successive nodes are linearly interpolated. The Delete button removes nodes. The 
Apply button recalculates the colours between the nodes, which is useful when the colour of 
some cells were changed. The Reset button restores the default colour table, which is a simple 
gradient between the colour ce11 index O and the colour ce11 index 255. The steps of configuring 
the palette are temporarily preserved in the memory and can be undone step by step with the 
Undo button. The configured Palette is applied by clicking on the OK button on the Palette editor 
dialog box. 

This Advanced palette mode is useful for configuring specialised palettes, such as a 
change of colour at given data-value steps (e.g., 3 dB steps) or to enhance the visibility of some 
sub-ranges of data values that present particular interest (e.g., the TS range of one fish species). 

6.2 Edit 1 Operators' list 

Al1 CH2 editing or classification operations performed on a HAC data file are tagged 
with the operator's identification. Many operators can edit the sarne HAC data file over time. A 
list of operators' identifications can be set up and recalled to select a current operator at CH2 
opening or during the editing session. The list resides in the ~indows95/98@ registry of the PC. 



Figure 6-4. Operators' list dialog box to add or edit CH2 operators' identifications. 
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The Edit / Operators' list menu is used to build or edit the list. This menu item opens the dialog 
box to define the operators' identification (Figure 6-4) and to edit the Operators' list. This dialog 
box can also be accessed via the specific dialog boxes of any editing or classification operation. 
Use the Ctrl+Enter keys to add lines in the Address or Comment boxes. To set the cunent 
operator, either double click on the name of your choice or select the name and click on the 
Select button and then on the OK button. 

6.3 Edit / Operation reason list 

A reason can be optionally attributed to every CH2 editing or classification operation. 
Since the same reasons may be frequently recalled during an editing session, CH2 offers the 
possibility of creating a list of common reasons that can be recalled every time the user wants to 
tag an editing or classification operation with a reason. The reasons are intended to be used in 
further data explorations by future CH2 versions, for example to locate special acoustic features. 
The use of a list has the advantage of standardising the labelling, which will be useful in further 
data processing. The Edit 1 Operation reason list menu is used to build or edit the list. This menu 
item opens the dialog box to define the reasons (Figure 6.5) and to edit the list. There is no limit 
to the length of the text defining the reason. This dialog box can also be accessed via the specific 
dialog boxes of any editing or classification operation. To set a cunent reason, select the reason 
and click on the OIS button. 
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Figure 6-5. Operation reason list dialog box to add or edit reasons 
used to tag CH2 editing or classification operations. 

6.4 Edit / Echo category list 

One important CH2 feature is the definition of regions of the echogram(s) for performing 
exclusion or classifying operations on the echo samples they contain. These regions are identified 
by echo category names. The user determines the echo category names, except for two special 
categories, Bad data and Exclude, and the names are added to the Echo category list. The user 
also determines the display attributes of the echo-category. CH2 computes separate 
echointegration results by echo category (see CH2 Echointegration tool, Section 8.6). In this 
version of CH2, the echo categories are defined by the user, from his knowledge of the nature of 
the echoes, which is often derived from ground-truthing observations obtained from various 
gears such as trawls, nets, and carneras. Subsequent versions of CH2 should incorporate high- 



level algorithms to produce objective echo classifications, such as multi-frequency algorithms 
and multi-channel image analysis. 

As with the other lists, the Edit 1 Echo category list menu is used to view and edit the 
Echo category list, as well as to determine the display attributes of the categories. Clicking on 
this menu item opens the Edit 1 Select Category dialog box, which displays the defined categories 
and their active state with a check box (Figure 6-6). The Bad data and Exclude categories are 
always included in the list and cannot be removed. See Chapter 8 for their definitions. The other 
echo categories are those defined by the user. To be visible on the echogram, the echo category 
must be active, which is indicated by the check in the box preceding the name. Echo category 
display is activated through the Properties button, which accesses the category attribute dialog 
box. Note: The name of the category is case sensitive, therefore "herring" and "Herring" are 
considered as two different categories by CH2. The colour property of the selected pattern also 
determines the colour of the tinted mask that will be blended with the echo sample colours 
defined by the echogram palette. The Echo categories can be defined for a region in both surface- 
or bottom-lock display modes. When the active display mode does not correspond to the display 

Figure 6-6. Echo Category list dialog boxes to add or edit the echo categories and their 
visualisation properties. 
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mode used when the region was defined, only the tinted mask is visible. When the mouse pointer 
is over an echo category region, its shape changes to a cross and a magnifying glass icon if the 
active display mode is the same as the one used when the region was defined. The characteristics 
of the operation performed on this region can then be displayed by a right click of the mouse. 

6.5 Edit / TVT(s) 

This menu item can also be accessed from a right click of the mouse. It serves to view 
andfor edit the parameters of the time-varied threshold(s) (TVT) used for the active echogram 
(Figure 6-7). The TVT is a threshold following the TVG law corresponding to the channel data 
type. The user first selects the TVT to be edited and then clicks on the View Characteristics or 
the Edit button to have access to its parameters. The corresponding TVT Offset (C) or 
Amplification (A) parameters can be changed for new values. Only values that increase the TVT 
for at least a portion of the total range are accepted. When the new parameter values increase the 

Figure 6-7. Edit TVT(s) dialog boxes to view and edit the parameters of the time-varied 
threshold(s) of the active echogram. Here the TVT is for a data channel in volts. 
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TVT for only a fraction of the total range, a warning message indicates the part of the total range 
where the new TVT will have no effect. The TVT equations are: A(20 log(R) + 203)  + C, for a 
20 log R TVG; A(40 log(R) + 203)  + C, for a 40 log R TVG in dB; and A R eBR + C, for a 20 log 
R TVG applied on data in volts. The absorption coefficients , a (in dB) and P (in nepers), are 
related by the equation P = a/  10 log (e). A click on the OK button of the edit parameters dialog 
box displays the effect of the TVT changes on the echogram. If the results are unsatisfactory, the 
user can go back to the edit parameter dialog box by clicking on the Edit button again or use the 
Cancel button to undo the editing. When an editing operation is performed, it is applied to the 
pings affected by the TVT, which start at the TVT time location up to the next TVT encountered, 
if any, or to the end of the corresponding run (or the file for single-run files). This adds a TVT 
editing operation to the operation list of the HAC file specific to the active channel. 

Single TVT editing or display can also be accessed directly from a right click on the 
mouse when the mouse pointer is over TVT icon and its shape is a cross and a magnifying glass 
icon. TVT icons are visible if this option has been selected in the View / Properties or Tools / 
Options menu. 
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VIEW MENU 

The View menu offers the following commands: 

Toolbar 
Palette bar 
S tatus bar 
Display other channels.. . 

Echosounder characteristics.. . 

Channel characteristics.. . 
Operation list.. . 

Previous zone 
Default view range 

Unzoom 

Pan view 

Show horizontal scale 
Show vertical scale 
Surface-lock 
Bottom-lock 
Ping 

Distance 

Time 
Properties 

Activates or deactivates the toolbar display. 
Activates or deactivates the palette display. 
Activates or deactivates the status bar display. 
Opens the View channel dialog box to choose additional 
channels to be displayed. 
Displays the echosounder configuration parameters for viewing 
or editing. 
Displays the characteristics of the active channel. 
Opens the View operation list dialog box to view the operation 
list and their characteristics. 
Returns to the previous display zone. 
Displays the active echogram window using the default view 
range of the Tools / Options. 
Displays the full view of the active channel in the echogram 
window, from range O up to the maximum detected bottom 
range (or height in bottom-lock mode) and from the first to the 
last ping, taking into account the Display every sample or 
Display every ping constraints of the View / Properties menu. 
Displays the full view of the active channel in the echogram 
window, from range O up to the maximum detected bottom 
range (or height in bottom-lock mode) and from the first to the 
last ping (Le., the entire echogram), ignoring the Display every 
samples and Display every pings constraints View / Properties 
menu. 
Activates or deactivates displaying the horizontal scale. 
Activates or deactivates displaying the vertical scale. 
Displays the active echogram window in surface-lock mode. 
Displays the active echogram window in bottom-lock mode. 
Displays the active echogram using the ping sequence as the X- 
axis units. 
Displays the active echogram using the distance as the X-axis 
units. 
Displays the active echogram using the time as the X-axis units. 
Opens the View properties dialog box to define the view 
settings for the active channel. 



7.1 View 1 Toolbar 

This option displays the CH2 toolbar below the main menus presenting icons to quickly 
access the common CH2 functions. These include al1 the functions available from the Tool menu 
plus other standard ~ i n d o w s "  functions. By default, the Toolbar bar is visible. Click on this 
option to deactivate or activate it. 

7.2 View 1 Palette bar 

This option shows the palette used to display the active echogram data. The Palette bar 
can be moved anywhere by dragging it. The range indicated is the range of values over which the 
palette is applied (see Edit 1 Palette, section 6.1). Values below the minimum or above the 
maximum are displayed using the minimum and maximum colours, unless the palette also 
includes limit colours, which assign particular user-defined colours to values below and above 
the user-defined lirnits. By default, the Palette bar is visible. Click on this option to deactivate or 
activate it. 

Figure 7-1. Exarnple of the View 1 Display other channels to display other channels of the 
active HAC file. Here a 120 kHz Sv additional channel, looking horizontally, is 
selected and will be displayed by clicking on the View button. 
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7.3 View 1 Status bar 

This option displays the CH2 status bar at the bottom of the main CH2 window. The 
objective of the selected function is displayed to the left of the status bar and the data 
characteristics of the active echogram at the pointer location are indicated on the right. These 
characteristics are, in order: the ping number, its time, the latitude and longitude 
(degree.decimals) if available, the range (m) from the transducer to the pointer, the range of the 
detected bottom (m) for that ping ("no bottom" for missed bottom), and the data value ("no 
sample" for samples below the TVT). By default, the Status bar is visible. Click on this option to 
deactivate or activate it. 

7.4 View 1 Display other channels... 

This function opens a dialog box showing the additional channels that can be displayed 
as echograms from the active HAC file. The characteristics of the selected channel are displayed 
(Figure 7-1). Select the additional channel to be opened, using the Shift or Ctrl keys to add 
channels to your selection, or use the Al1 channels button to select them dl .  Then click on the 
View button to display the selected channels. The channels will be displayed using the default 
palette associated with the corresponding type of data (see Edit 1 Palette, section 6.1). Use the 
Window 1 Tile menu if you want to tile the echogram windows. Note that the EK500 split-beam 
phase angle channel cannot be displayed as an echogram, such viewing being of questionable 
interest. 

7.5 View / Echosounder 

characteristics.. . 
This function displays 

the configuration characteristics 
of the echosounder for the 
active echogram that are stored 
in the Echosounder tuple 
(Figure 7-2). For the Biosonics 
echosounder, the dialog box 
allows the editing of some 
fields (Figure 7-3). When an 
editing operation is performed, 
a new (edited) Echosounder 
tuple is created and the 
operation is added to the 
operation list. The tuple 
attribute is changed from 
"original" to "edited". This 

Figure 7-2. Visualisation of the echosounder configuration 
at acquisition for the EK500 echosounder. 
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Figure 7-3. Visualisation of the echosounder configuration at 
acquisition for the Biosonics type of echosounder in 
the edit mode, showing the fields that can be edited 
with a white background. 

function is also available from a right click on the mouse. 

7.6 View 1 Channel characteristics.. . 
This function displays the characteristics of the active channel at acquisition, which are 

stored in the Channel tuple (Figure 7-4). This function is accessed more rapidly with the mouse 
right button. 
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Figure 7-4. Exarnple of the View 1 Channel characteristics to look at the channel 
properties. This option is also accessible from the mouse right button. 

7.7 View / Operation list.. . 

This function shows the list of the editing/classification operations performed on the active 
HAC file. The operations are presented in the order they were performed (Figure 7-5). The 
characteristics of the selected operation are displayed. In a future version of CH2, the user will be 
able to edit the operation from this dialog box. To directly access a specific operation associated 
with a region through this dialog box, use the mouse right button when the pointer is over the 
region and appears as a cross and a magniQing glass. 
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1 Figure 7-5. Visualisation of the Operation list and the characteristics of the 1; 
selected operation through the View menu or the rnouse right 14 
click. 

7.8 View 1 Previous zone 

CH2 can visualise the whole echogram for the active Channel or part of it according to the 
display preferences chosen or the zooming state. The Previous zone function is used to rapidly 
bring back the previously displayed zone, which is often done while zooming on portions of the 
echogram. Note that CH2 does not zoom on bitmaps but always displays al1 the data allowed by 
the window viewing properties (view options, window size, pixel resolution, etc.). 



7.9 View 1 Default view range 

This function adjusts the vertical scale of the active echogram to the default range (or 
height in the bottom-lock mode) specified in the Tools 1 Options menu. It only affects the vertical 
aspect of the echogram. This function is also directly available from the mouse right button. 

7.10 View 1 Unzoom 

This function displays the full view of the active channel in the echogram window, 
subject to the constraints in the View / Properties menu. The horizontal limits are deterrnined by 
the first and 1 s t  pings unless the Display every ping constraint is selected in the View / 
Properties menu. The maximum detected range gives the vertical range limit unless the Display 
every sarnple constraint is selected in the View / Properties menu. This function is also directly 
available from the mouse right button. 



7.1 1 View / Pan view 

This function displays the full view of the active channel in the echogram window (i.e., 
the entire echogram), ignoring the Display every ping and Display every sample constraints in the 
View / Properties menu. The horizontal lirnits are deterrnined by the first and last pings. The 
maximum detected range gives the vertical range lirnit. This function is also directly available 
from the mouse right button. 

7.12 View / Show horizontal scale 

This option is used to activate or deactivate the display of the horizontal scale on the 
active echogram window. The display format is set in the View / Properties or Tools / Options 
(see section 8.7) menus. This function is also directly available from the mouse right button. 

7.13 View / Show vertical scale 

This option is used to activate or deactivate the display of the vertical scale on the active 
echograrn window. The display format is set in the View / Properties or Tools / Options (see 
section 8.7) menus. This function is also directly available from the mouse right button. 

7.14 View 1 Surface-lock 

This option is for displaying the echogram in surface-lock mode (i.e., the echo samples 
are displayed top down from range O) (Figure 7.6). This is the CH2 default display mode. Note 
that when a region has been edited or classified in the alternative bottom-lock display mode, the 
region is displayed only with a tinted mask without the hatching (see section 6.4). This function 
is also directly available from the mouse right button. 

7.15 View / Bottom-lock 

This option is for displaying the echogram in bottom-lock mode. The echo samples are 
displayed bottom up from the detected bottom range plus an offset, which is deterrnined in the 
View / Properties menu. Note that when a region has been edited or classified in the alternative 
surface-lock display mode, the region is displayed only with a tinted mask without the hatching 
(see section 6.4). This function is also directly available from the mouse right button. 

7.16 View / Ping 

This option is for displaying the active echogram using the ping sequence as the X-axis 
units. This view property can also be set in the View 1 Properties menu for the active channel and 
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in the Tools / Options menu for the CH2 default setting. This function is also directly available 
from the mouse right button. 

7.17 View 1 Distance 

This option is for displaying the active echogram using the distance as the X-axis units. 
This view property can also be set in the View 1 Properties menu for the active channel and in the 
Tools / Options menu for the CH2 default setting. This function is also directly available from 
the mouse right button. 

7.18 View 1 Time 

This option is for displaying the active echogram using the time as the X-axis units. This 
view property can also be set in the View / Properties menu for the active channel and in the 
Tools / Options menu for the CH2 default setting. This function is also directly available from 
the mouse right button. 

7.19 View 1 Properties 

This item displays the View Properties dialog box with its four tabs to set the preferences 
for displaying the active echogram (Figure 7-7). It works as the Tool / Options dialog box (see 
section 8.7) except that the changes made to the parameters only apply to the to the active 
echogram unless the user updates the CH2 default by clicking on the Set as default button. 

Figure 7-7. The View 1 Properties menu to set the preferences for 





8. TOOLS MENU 

The Tools menu offers the following cornmands, al1 of which can be accessed directly 
through a series of icons on the tool bar. 

Regions definition tools: 
Rectangle and zoom Defines a rectangular region(s) for zooming or performing a 

classificatiordediting operation on a channel(s). 
Ellipse $$ Defines an elliptical region(s) for performing a 

classificatiordediting operation on a channel(s). 
Polygon Idem for a polygon region(s). 
Above polyline !# Idem for a region(s) above a polyline(s). 
Below polyline Idem for a region(s) below a polyline(s). 
Whole echogram Idem for the whole echogram. 
Selected runs Idem for selected run(s). 
Selected pings Idem for selected ping series. 

Manual bottom tools: 
Bottom samples Manually sets the bottom-detected range by clicking on the echo 

sample for one or several pings. 
Bottom line Manually defines a polyline(s) that will determine the bottom- 

detected range. 
Cumulative distance @ Computes the horizontal cumulative distance (i.e., from ping to 

ping), between two pings selected from the line that is drawn 
with the mouse. 

Insert TVT(s) &, Adds a time varied threshold(s) to the active channel. 
Editladd positions via Excel Edits, deletes, or adds positions to the active file via ~xce l@.  

Echointegration ;A& Computes s, or sa echointegration results by Echo category for 
chosen channels, blocks of runs, surface- or bottom-locked depth 
strata, along horizontal steps defined in ping, time or distance 
intervals. 

Options Sets the CH2 default view options. 

8.1 Tools / Region definition group 

This group of tools defines regions of the echograrn to edit or classify (Figure 8-1). It is at 
the heart of the CH2 editing and classification features. Any operation performed on the data by 
CH2 is first done on one or more XZ regions of the multichannel HAC data. A region could be 
the entire data set or a portion of it, which could be as small as a single echo sample. The region- 
definition tools serve to delineate these regions before performing an operation. Various shapes 
or echogram selection tools can be used to define regions as described below. It is possible to 
define many regions of the same type in a single operation by holding down the shift key. The 
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common Classify or Exclude operations can be performed on al1 types of regions. Additional 
functions to modify the detected bottom range are associated with regions whose CO-ordinates 
always include the bottom zone. The zoom on portions of the echogram is a special function 
associated with the rectangular region. For al1 region-definition tools, it is possible to project the 
defined region(s) to the other channels of the HAC file so that the editing/classification operation 
is performed on the same depth-referenced region on the additional selected channels. Warning: 
When the cursor is in the region-definition mode, the mouse displacement is confined to the part 
of the PC display represented by the active echogram window. If the user switches to another 
software application while the cursor is still in this mode, he will not be able to move the mouse 
on the whole display until the operation is applied or the CH2 region definition mode is 
cancelled (by the Esc key). 

1 1 Tools to defme regions for an edition or classification operation 1 a 

Figure 8-1. The region definition tools applied on an echogram and the right-click menus 
showing the edition/classification operations associated with the different 
types of regions. Note that al1 regions can be projected to additional channels 
before performing the operation. 
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Regions can be defined in surface-lock or bottom-lock view modes. The defined regions 
are displayed on the echogram in a way that reveals their native view mode. When the active 
view mode is the same as the one used when the region(s) was (were) created, the region(s) is 
(are) displayed with a hatched shaped plus a tinted mask over the selected samples. The mask 
colour is a 20% blend of the hatching colour wi:h the colour of the samples from the echogram 
palette. The hatching properties for the echo categories are defined in the Echo category list (see 
section 6.4). By pointing on a region in its native view mode, the cursor shape changes to 
indicate that the characteristics of its operation can be viewed from a right click on the mouse. 
When the active view mode is not the same as the one used when the region(s) was (were) 
created, the region is only displayed with the tinted mask and the operation characteristics cannot 
be viewed from a right click on the mouse when the pointer is over the region. Warning: The 
regions are only visible when their specific Echo category is activated in the Echo category list. 

When a region or a series of regions have been defined, possibly projected to many 
channels, and an editing/classification operation has been applied to them, a new tuple of the type 
specific to the particular operation is created and the operation is added to the Operation and 
Undo lists. The operation tuple contains the CO-ordinates of the region(s) and channel(s) as well 
as the operation parameters. 

8.1.1 Tools /Rectangle and zoom & 

To define a Rectangle region on the echogram, select this type of region from the Tools 
menu or click on the Rectangle tool icon of the toolbar. The pointer shape switches to a cross and 
a rectangle, and its displacement (including al1 other running applications) is confined to the 
active echogram window until the operation is completed or cancelled by the Esc key. Move the 
cross on the echogram to the location of one corner of the region to be defined and drag to the 
opposite corner of the rectangle. The selected area appears in inverse video colours. Note that to 
define more than one rectangle for the operation to be perfomed, simply hold the shift key and 
repeat these steps. Right click to display the menu of the operations that can be perfomed on the 
defined region. Warning: The selected Rectangle region includes the echo samples of the 
leftmost and the rightmost pings of the rectangle. Thus, the Rectangle tool can be used to select a 
series of samples belonging to a single ping. This is done by drawing a rectangle over the 
sarnples of interest, when the echogram is sufficiently zoomed to allow a single ping to be 
displayed with many pixels. 

First, if the editing/classification operation has to be applied to other channels in addition 
to the active one, use the Project to other channels option to select the additional channels. The 
channel dialog box opens to display the channel characteristics and to select the channels (see 
View / Display other channels, section 7.4). Use the shift andlor ctrl key to select more than one 
channel or use the Al1 channels button to select al1 additional channels. 

Second, select the operation to be performed among the four possibilities: Zoom in, 
Classify, Exclude or New bottom detect level. 



8.1.1.1 Zoom in 

Figure 8-2. Use of the Rectangle and zoom tool to zoom on a portion of the echogram. The 
echogram window is changed for the one on the right. Note that CH2 zoomed on 

When Zoom in is chosen, the echogram is redrawn to display only the zoomed 
zone in the echogram window (Figure 8-2). Scroll bars on the window border show the 
location of the zone relative to the echogram pan view. Unlike usual ~ indows95/98@ 
applications, CH2 does not zoom on the bitmap but instead loads into the window al1 the 
new pings and echo samples that the window pixels allow for the zoomed region (e.g., 
Figure 4-6). The sarne process happens when the size of an echogram window is 
changed. For large files this sometimes requires the reading of HAC data from disk, 
which is not always instantaneous on slow drives or PCs. 

the data, not on the bitmap, and loaded al1 new echo samples and pings that the 
window size allowed to display at that viewing scale. Note also that the 
automatic Z-scale mode was active. 

,:i 
; 
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8.1.1.2 Classify operation 

When Classify is chosen, the corresponding dialog box opens. By default, the 
pararneters of the last Classify operation (if any) are offered (Figure 8-3). If these are 
satisfactory, simply click on the OK button to accept them and to classify the region(s) 
accordingly. Othenvise, click on the Select or Change buttons to define andlor select new 
ones. You can add an Echo category or a Reason or change the Operator as indicated in 
the respective Edit menus (Chapter 6). By clicking on the OK button, the operation is 
applied and the classified region is identified by a hatched shape and a tinted mask, if the 
display of the selected Echo category is activated (see Edit 1 Echo category list, section 
6.4). A Classification tuple (HAC tuple no. 13000) containing al1 the parameters of the 
operation is generated. The characteristics of the operation can be viewed by pointing on 
the classified region, which turns the pointer shape to a cross and a magnifying glass, and 

Figure 8-3. The Rectangle and zoom region definition tool applied to classify a portion of the 
echogram(s). The Classify dialog box offers the parameters used for the last 
Classify operation as default values. The buttons at the right are used to make 
new selections. 



a right clicking the right mouse button to select the View operation characteristics (Figure 
8-4). 

In classifying a region, a special Echo category called Bad data can be used. 
Warning: This category should be used with caution to mark a region(s) as containing 
unreliable data that will be considered as unsampled in subsequent data processing, such 
as echointegration. These data will be handled as rnissing data, which will affect both the 
computed s, and s, values (see Integration, section 8.6.6). 

Figure 8-4. Viewing the operation characteristics applied to a region by pointing on its 
hatched shape and right clicking on the mouse. Note that this Classify operation 
has been applied here on the channels O, 1, and 2. 
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Figure 8-5. Exain~île of the Exclude operation, exçl~iding signals shorter than the pulse 
duration on a region defined as the Whole echogram, which appears in inverse 
video in the uppcr window. The result of the operation is shown on the bottom 
window, where al1 sharp electrical interference and insignificant echoes wese 
excluded and a halching is applied on the whole echogsam to indicate the 
operation. 
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8.1.1.3 Exclude operation 

When Exclude is chosen for the operation to be performed, selected echo samples 
can be labelled as excluded from the defined region of the echogram. From the Exclude 
dialog box, selecting the Al1 signal item of the scroll box (Figure 8-5) excludes al1 echo 
samples from the region. The other options exclude the echo samples according to a 
selected contiguity criterion, e.g., the duration of the echo. For the EK500 echosounder 
the two possibilities offered are to exclude echoes shorter or longer than a given duration 
in ms. For the Biosonics type of analog echosounder, the time duration can also be given 
as a factor of the pulse duration. When the operation is applied by clicking on the OK 
button, a Replaced signal edition tuple (HAC tuple no. 12010) containing al1 the 
operation parameters is generated. Warning: The excluded echo samples are simply 
replaced by nul1 values for the corresponding channel. Note that in further data 
processing, such as echointegration, these data will be handled as such, which will affect 
both the computed s, and sa values (see Integration, section 8.6.6). For proper use of 
CH2, it is important to distinguish between the Excluded regions (zeros) and the Bad data 
regions (rnissing data). 

8.1.1.4 New bottom detect level operation 

When New bottom detect level is the chosen operation, a defined echo sample 
level is searched for within each ping included in the region. The required dialog box 
parameter is the new echo sample level in the active channel units (Figure 8-6). The 
Bottom displacement constraint is an optional parameter that constrains the bottom 
displacement to a given range (m) around the present detected bottom. For those pings 
where the criteria are not met, the detected bottom remains unchanged unless the Assign 
"No Bottom" if detection criteria are not met option is checked, in which case an 
undetected bottom flag is assigned. The bottom search is done top down. The first echo 
sample greater than or equal to the new bottom detection level is accepted as the new 
bottom, if the previous echo sample was smaller than the new bottom detection level and 
the bottom displacement constraint is not exceeded. Note that this implies that the bottom 
cannot be found for a ping when its echo sample values in the selected region are 
constantly decreasing. When the operation is applied, a statistics table gives the number 
of pings where the detected bottom was changed or unchanged, and those flagged with no 
Detected bottom as well as the reason for the resulting status. On the echogram, the echo 
sample corresponding to the detected bottom is coloured with the bottom colour defined 
by the palette. When a New bottom detect level operation is applied, a corresponding 
edition tuple is created (HAC tuple no. 12053) and contains the parameters of this 
operation. Warning: It is important for further data processing, such as echointegration, 
to set the bottom at the right range because the echointegration stops at the detected 
bottom and bottom depth strata are referred to this range. Similarly, al1 pings with an 
undetected bottom are ignored during echointegration (see Echointegration, section 8.6). 



Figure 8-6. Example of the New bottom detect level operation with the Rectangle region. 
Here the bottom detection level within the rectangle is changed to -25 dB, which 
moved the detected bottom closer to the interface in the rectangle. If this level is 
not found, the bottom is labelled as undetected since this option was selected. 
The statistics table indicates that the new -25 dB level changed the detected 
bottom for 44 of the 56 pings of the rectangle, 11 pings had no changes and 1 
ping was tagged with no detected bottom. 
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8.1.2 Tools /Ellipse @? 

To define an Ellipse region on the echogram (e.g., Figure 8-l), select this type of region 
from the Tools menu or click on the Ellipse tool icon of the toolbar. The pointer shape switches 
to a cross and a circle, and its displacement is confined to the active echogram window 
(including al1 other running applications) until the operation is completed or cancelled by the Esc 
key. Move the cross on the echogram to the location of one corner of the virtual rectangle 
enclosing the ellipse to be defined and drag to the opposite corner of the rectangle. The selected 
area appears in inverse video colours. To define more than one ellipse region for the operation to 
be performed, simply hold the shift key and repeat the last steps. Right click to display the menu 
of the operations that can be performed on the defined region. 

This tool works like the Rectangle tool (see Rectangle and zoom tool, section 8.1.1) 
except that the operations available with the Ellipse region are limited to Classify and Exclude. 
To properly superimpose the hatched ellipse shape with the ellipse mask over the selected 
samples, the echogram view mode must be in time, not in pings or distance. 

8.1.3 Tools / Polygon % 
To define a Polygon region on the echogram (e.g., Figure 8-l), select this type of region 

from the Tools menu or click on the Polygon tool icon of the toolbar. The pointer shape switches 
to a cross and a polygon and its displacement is confined to the active echogram window 
(including al1 other running applications) until the operation is completed or cancelled by the Esc 
key. Move the cross on the echogram to the location of one vertex (the point of intersection of 
two sides) of the polygon to be defined and click to set the vertex. Repeat for the other vertices 
and double click to close the polygon. The selected area appears in inverse video colours. Note 
that to define more than one polygon region for the operation to be performed, simply hold the 
shift key and repeat the last steps. Right click to display the menu of the operations that can be 
performed on the defined region. 

This tool works like the Rectangle tool (see Rectangle and zoom tool, section 8.1.1) 
except that the operations available with the Polygon region are limited to Classify and Exclude. 
Crossing the polygon segments is allowed when defining the region, which creates strange 
polygonal shapes with holes. This non-standard procedure is at the user's risk. When the hatched 
shape is drawn, the polygon vertices are placed in the middle of the selected echo sample image, 
even if the mouse clicked elsewhere on the echo sample. This is visible only during large zooms 
on the echogram, when the echo samples are represented by many pixels. The selected echo 
samples of a polygon region are al1 enclosed samples. This includes: 1) the echo samples 
belonging to the pings intersected by a polygon edge (the ping intersection line is the virtual line 
marking the beginning of the ping) and 2) those from vertical polygon edges (i.e., consecutive 
vertices on the same ping). Warning: CH2 does not allow the drawing of a polygon in which al1 
vertices are within a single ping. Use the Rectangle and zoom tool (see section 8.1.1) to select a 
series of echo samples from a single ping. 



8.1.4 Tools / Below polyline $d 

To define a region below a polyline on the echogram (e.g., Figure 8-l), select this type of 
region from the Tools menu or click on the Below polyline tool icon of the toolbar. The pointer 
shape switches to a cross and a polygon whose upper boundary is a polyline; its displacement is 
confined to the active echogram window (including al1 other running applications) until the 
operation is completed or cancelled by the Esc key. Move the cross on the echogram to the 
location of the first point of the polyline to be defined and click to set the point. Repeat for the 
other vertices and double click to end the polyline. Convex and concave polylines, including 
retums to already-selected pings, are possible. Crossing defined polyline segments is allowed 
when drawing the polyline, which can create strange polygonal shapes with holes. This non- 
standard procedure is at the user's risk. The selected area appears in inverse video colours. It is 
defined as a polygon drawn below the polyline down to a very large range. The region includes 
the leftmost and the rightmost pings of the polyline. Note that to define more than one polyline 
for the operation to be performed, simply hold the shift key and repeat the last steps. Right click 
to display the menu of the operations that can be performed on the defined region. 

This tool works like the Rectangle tool (see Rectangle and zoom tool, section 8.1.1) 
except that the search for a New bottom detect level is lirnited to ranges below the polyline. The 
selected echo samples of a Below polyline region are al1 sarnples below the polyline, taking into 
account the above-mentioned concave and convex possibilities. This includes: 1) the echo 
samples belonging to the pings intersected by a polyline edge (the ping intersection line is the 
virtual line marking the beginning of the ping) and 2) those from vertical polygon edges (i.e., 
consecutive vertices on the same ping). 

8.1.5 Tools /Above polyline & 
To define a region above a polyline on the echogram (e.g., Figure 8-l),  select this type of 

region from the Tools menu or click on the Above polyline tool icon of the toolbar. The pointer 
shape switches to a cross and a polygon whose lower boundary is a polyline; its displacement is 
confined to the active echogram window (including al1 other running applications) until the 
operation is completed or cancelled by the Esc key. Move the cross on the echogram to the 
location of the first point of the polyline to define and click to set the point. Repeat for the other 
vertices and double click to end the polyline. This region type works as a mirror of the Below 
polyline region (refer to section 8.1.4), except that the New bottom detect level operation is not 
available with this type of region. 

8.1.6 Tools / Whole echogram [Zl 

To define a region as the whole echogram (e.g., Figures 8-1 and 8-6), select this type of 
region from the Tools menu or click on the Whole echogram tool icon of the toolbar. The whole 
echogram appears in inverse video colours. The pointer shape switches to a cross and a rectangle, 
and its displacement is confined to the active echogram window (including al1 other running 
applications) until the operation is completed or cancelled by the Esc key. Right click to display 
the menu of the operations that can be performed on the defined region. 



This tool works like the Rectangle tool (see Rectangle and zoom tool, section 8.1.1) 
except that a new Move bottom operation is available. The Move bottom operation is detailed in 
section 8.1.6.1. The search for a New bottom detect level is not limited to a range interval. 



8.1.6.1 Move bottom operation 

When the Move bottom operation is selected, the corresponding dialog box opens to give 
the offset (m) to move the detected bottom from its present range (Figure 8-7). Positive 
values deepen the detected bottom and negative values do the opposite. The usual option 
of typing a reason for the operation or selecting one from the Reason list via the Select 
button is offered as is the possibility of changing the current operator that will be attached 
to the operation. By clicking on the OK button, the detected bottom is moved and the 
echo sample corresponding to its new range is set to the active palette bottom colour. 
When a Move bottom detect level operation is applied, a corresponding edition tuple is 
created (HAC tuple no. 12051) and contains the parameters of this operation. wArning: 
It is important for further data processing, such as echointegration, to set the bottom at the 
right range because the echointegration stops at the detected bottom and bottom depth 
strata are refened to this range (see Echointegration, section 8.6). This Move bottom 
operation is often used to slightly offset the bottom to insure that no bottom echoes will 
be included in the echointegration. 

8.1.7 Tools / Selected runs 

To define a region for a single run or a series of runs on the echograrn of the HAC data 
channel, select this type of region from the Tools menu or click on the Selected runs tool icon of 
the toolbar. The pointer shape switches to a cross plus hatched rectangle; its displacement is 
confined to the active echogram window (including al1 other running applications) until the 
operation is completed or cancelled by the Esc key. To select a run, click on the echogram 
anywhere in the desired run. The selected run(s) appears in inverse video colours. To define more 
than one run for the operation to be performed, simply hold the shift key and repeat the selection 
for other runs. Right click to display the menu of the operations that can be performed on the 
defined region. 

This tool works like the Rectangle tool (see Rectangle and zoom tool, section 8.1.1) except 
that the Move bottom operation is available. The Move bottom operation is detailed in section 
8.1.6.1. The search for a New bottom detect level is not limited to a range interval. 

8.1.8 Tools / Selected pings a] 
To define a region for a single ping, or a series of pings on the echogram, select this type 

of region from the Tools menu or click on the Selected runs tool icon of the toolbar. The pointer 
shape switches to a cross and a bar in a rectangle, and its displacement is confined to the active 
echogram window (including al1 other running applications) until the operation is completed or 
cancelled by the Esc key. To select a ping, simply click on it. To select a series of pings, click on 
the first ping of the series and drag to the last one. The selected ping(s) appears in inverse video 
colours. To define more than one ping or series of pings for the operation to be performed, 
simply hold the shift key and repeat the selection steps (e.g., Figure 8-7). Right click to display 
the menu of the operations that can be performed on the defined region. 
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This tool works like the Rectangle tool (see Rectangle and zoom tool, section 8.1.1) except 
that the Move bottom operation is available. The Move bottom operation is detailed in section 
8.1.6.1. The search for a New bottom detect level is not limited to a range interval. Warning: A 
highly zoomed view or the Display every ping option of the View / Properties menu (see section 
7.19) is needed to view al1 pings on the echogram window. In a series of pings, al1 pings between 
the first and the last of the series are parts of the selected region, even if some of them are not 
displayed on the echogram. 

Figure 8-8. Example of the Bottom sample tool to set the bottom manually. Once the tool is 
selected, a click on the echogram selects the bottom sample for the conesponding 
ping. The selected echo sample is indicated in inverse video colour. This is 
repeated for the other pings of interest. The operation is then applied by selecting 
the Define new bottom from the right-click menu and the detected bottom is 
moved to the selected range for each ping chosen. 

8 
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8.2 Tools 1 Manual bottom tools 

CH2 has two tools to set the detected bottom manually. The Bottom sample tool fixes the 
bottom at the range given by the mouse click for selected ping(s). The Bottom line tool sets the 
bottom by drawing a polyline on the echograrn. 

Figure 8-9. Example of the Bottom line tool to set the bottom manually. Once the tool is 
selected, a series of clicks on the echogram draws a polyline defining the 
replacement of the detected bottom for al1 pings intersected by the polyline. The 
polyline is ended by a double click. The operation is then applied by selecting the 
Define new bottom from the right-click menu and the detected bottom is moved 
to the polyline. Here the operation was previously projected to al1 other channels 
using the Project to other channels option first. 



8.2.1 Tools / Bottom sample 

To manually set the detected bottom of individual pings with a mouse click, select the 
Bottom samples tool from the Tools menu or click on its icon from the toolbar (Figure 8-8). The 
pointer shape switches to a cross and a horizontal bar in the rniddle of a rectangle; its 
displacement is confined to the active echogram window (including al1 other running 
applications) until the operation is completed or cancelled by the Esc key. To select an echo 
sample of a ping, simply click on it. This can be done for al1 pings of interest. To change the 
selected echo sarnple of a ping, simply click on a new one. The selected sample(s) appears in 
inverse video colours. Right click to access the Define new bottom operation and the Project to 
other channel option. The New bottom dialog box allows the inscription of a reason for the 
operation and to change the operator's name. The operation is applied by clicking on the OK 
button and the detected bottom is set to the selected echo sample(s) for the chosen ping(s). When 
a New bottom operation is applied, a corresponding edition tuple is created (HAC tuple no. 
12050) that contains the parameters of this operation. This Manual bottom operation is identified 
as New bottom from polyline in the Operation list as the next operation (section 8.2.2), the 
polyline(s) here being lirnited to the width of a ping. Warning: It is important for further data 
processing, such as echointegration, to set the bottom at the right range because the 
echointegration stops at the detected bottom and bottom depth strata are referred to this range 
(see Echointegration, section 8.6). 

8.2.2 Tools / Bottom line ?$? 
To manually set the detected bottom for a series of pings, from a polyline drawn by the 

mouse, select the Bottom line from the Tools menu or click on its icon from the toolbar (Figure 
8-9). The pointer shape switches to a cross and a polyline, and its displacement is confined to the 
active echogram window (including al1 other running applications) until the operation is 
completed or cancelled by the Esc key. Move the cross on the echogram to the location of the 
first point of the polyline to define and click to set the point. Repeat for the other vertices and 
double click to end the polyline. Note that the Polyline is not valid when it intersects a ping more 
than once. To define other polylines for simultaneously perforrning the operation over other ping 
series, simply hold the shift key and repeat the drawing steps. Right click to access the Define 
new bottom operation and the Project to other channel option. The New bottom dialog box 
allows the inscription of a reason for the operation and to change the operator's name. The 
operation is applied by clicking on the OK button and the detected bottom is set to the selected 
echo sample(s) for the chosen ping(s). When a New bottom operation is applied, a corresponding 
edition tuple is created (HAC tuple no. 12050) that contains the parameters of this operation. 
This Manual bottom operation is identified as New bottom from polyline in the Operation list as 
the previous operation (section 8.2.1) with the Bottom samples tool. Warning: It is important 
for further data processing, such as echointegration, to set the bottom at the right range because 
the echointegration stops at the detected bottom and bottom depth strata are referred to this range 
(see Echointegration, section 8.6). 
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Figure 8-10. Example of measuring the cumulative (Le., sailed) horizontal distance 
between a series of pings with the Cumulative distance tool. Select the tool 
and click on the first ping and hold to the last ping of the series. At the release 
of the mouse button, the time and CO-ordinates of the two pings as well as the 
cumulative distance (m) between them are given. 

8.3 Tools / Cumulative distance @ 

To get an estimate of the cumulative (Le., sailed) horizontal distance between two pings, 
select the Cumulative distance from the Tools menu or click on its icon from the toolbar (Figure 
8-10). The pointer shape switches to a cross and a line, and its displacement is confined to the 
active echogram window (including al1 other running applications) until the operation is 
completed or cancelled by the Esc key. Click on the first ping of the series and hold the mouse 
button by moving the pointer to the last ping. A horizontal line is displayed to indicate the series 
of pings being selected. At the release of the mouse button, the time and CO-ordinates of the first 
and last pings of the series as well as the cumulative distance (m) between them are given. 
Warning: The measured distance will be longer than the actual (shortest) distance between the 
two pings if the sailing route was not a straight line. 



8.4 Tools 1 Insert TVT(s) % 

To insert a TVT or a set of two TVTs for the active channel, select the Insert TVT tool 
from the Tools menu or click on its icon from the toolbar (Figure 8-1 1). The pointer shape 
switches to a cross and a curve in a rectangle; its displacement is confined to the active echogram 
window (including al1 other mnning applications) until the operation is completed or cancelled 
by the Esc key. The TVT is a threshold following the TVG law corresponding to the channel data 
type. HAC data files recorded with CH1 have at least one TVT inserted at the beginning of each 
run (or the file for single run files) for each relevant data channel. A TVT applies to the series of 
pings starting at the TVT time location up to the next TVT encountered, if any, or to the end of 
the run (or the file for single run files). 

Figure 8-1 1. Example of inserting a set of two TVTs over a series of pings with the Insert 
TVT tool. First, select the tool, then click on the first ping and drag to the last 
ping of the series. At the release of the mouse button, the Create left limit TVT 
tuple dialog box opens to define the TVT parameters to apply to the series of 
pings. The OK button then opens the Create right limit TVT tuple dialog box. 
By accepting the default parameters for the right limit, the Insert TVT operation 
only effects the selected pings. Results are shown in the next figure. 

Tools Meng 



1 Figure 8-12. Example of inserting a TVT affecting ail following pings, up to the next TVT or 
to the end of run or file (for single run files) with the Insert TVT tool. Select the 
tool and click on the echogram at the desired time location for insertion (which 
can be changed for two other alternatives) and give the TVT parameters, then 
click on the OK button. 



To insert a set of two TVTs at the beginning and at the end of the series, drag over a 
series of pings (Figure 8-1 1). The selected pings are displayed in inverse video and the Create left 
limit TVT tuple dialog opens with the existing parameter values when the mouse button is 
released. Edit the TVT Offset (C) and Amplification parameters (A), an optional reason for the 
operation, and change the operator's name as required. Clicking on the OK button then opens the 
Create right limit TVT tuple dialog box. The parameters corresponding to the TVT presently 
applied at this ping are displayed as default values for the TVT at the end of the selected ping 
series. By accepting them, the insert TVT operation only affects the selected pings of the series. 
A click on the OK button applies the TVT operation and its effect is displayed on the echogram. 

To insert a TVT from a given time up to the next TVT or the end of run or of file for 
single mn files, first click on the echogram (Figure 8-12). At the release of the mouse button, the 
Create single TVT tuple dialog box opens. The Time scroll box first offers three alternatives for 
the time from which the TVT will be applied: the time at the beginning of the file, at the 
beginning of the run, or from the position at the pointer. Fil1 in the fields as above and insert the 
TVT by clicking on the OK button. 

If the results are unsatisfactory, the TVT operation can be undone by the CH2 Undo 
operation function (see Chapter 9). Each inserted TVT adds a General threshold tuple (HAC 
tuple no. 10100) to the HAC file. 

Warning: Only values that increase the present TVT will have an effect on the data. The 
TVT equations are: A(20 log(R) + 2aR) + C, for a 20 log R TVG; A(40 log(R) + 2aR) + C, for a 
40 log R TVG; and A R ePR + C, for a 20 log R TVG applied on data in volts. The absorption 
coefficients, a (in dB) and P (in nepers), are related by the equation P = a /  10 log (e). 

Warning: Since TVTs have an effect on the subsequent data processing steps, such as 
echointegration (see section 8.6), they should be used with caution. If the purpose is only to see 
the effects of range-constant thresholds on echointegration results, CH2's Echointegration 
threshold parameter (see Echointegration 1 Channel tab, section 8.6.2) should be used instead of 
the Insert TVT tool. Sirnilarly, if the purpose is only to visualise data above given thresholds, the 
limits option of the Palette is recommended (see Edit 1 Palette menu, section 6.1). Note that the 
Insert TVT tool does not offer the possibility of being projected to other channels, because TVTs 
are specific to the data type and to the noise level of the channel. 



8.5 Tools 1 Edit/add positions via Excel wp 

This tool is for processing position data via an ~ x c e l @  worksheet (version ~ i c r o s o f t ~  
0ffice97@). It is a multi-purpose tool that cari be used to view, export, add, check, edit, or delete 
positions associated with the current HAC data file. Accurate and precise positions are important 
for many CH2 operations, namely visualisation in distance mode, measuring distances, and 
definiting echointegration step lirnits. Errors in positions originating from poor GPS performance 

I Figure 8-13. Edit/add positions via Excel tool: Sending positions to Excel. 

or bad GPS settings, or the absence of positions in some HAC files (e.g., generated by CH1 from 
archived data on magnetic tapes) can strongly impede, or inhibit, the application of these 
operations. Position data can be used by auxiliary software to plot the ship's track. This Editfadd 
positions via Excel tool was designed to provide an adaptable means of allowing CH2 users to 
process position data. 

First, before clicking on the Editladd positions in Excel tool, make sure that ~ x c e l @  is 
closed, or does not have any active worksheets if it is open, to allow CH2 to establish a clean 
link with ~ x c e l @ .  Clicking on the tool opens the send position box (Figure 8-13). The Send 
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positions function does the following: it opens ~ x c e l @ ,  if it is not already open, it loads the 
TplPos.xlt Excel template that contains Visual Basic rnacros to view and edit positions, and, if 
the HAC data file contains position tuples, it fills the worksheet with the HAC file position data 
that are within the boundaries of the Run time lirnits given by the Start of run and End of run 
tuples. This may take some time if the file contains many positions. A progress bar monitors the 
data transfer (Figure 8-13). Then the user's view is focused on the Excel spreadsheet, where 
several new colurnns are computed from the position and time data. When this is done, the user 
can use the rnacros to check and edit the position data or to bring in new positions with the usual 
~ x c e l @  functions. Note that the Excel 1 Window 1 split option is active, which divides the 
worksheet at line 17. 

since fiisi T m e  CPU . 

999 1937W12 2337M O 10 -1M0' 63 595905 46073334 

Figure 8-14. Editladd positions via Excel tool: Adding new positions. 1 '  
To add positions, simply insert new lines (if necessary) and type (or paste) the new 

position information in the eight CH2 sensitive columns, indicated with a blue background on 
the headings (Figure 8-14). CPU-time information is in columns A, B, and C, the GPS-time in 
colurnns E, F, and G, and the position in columns J and K. The date format is yyyy-mm-dd and 
the time is hh:mm:ss. For the spatial CO-ordinates, negative values are used for western 
longitudes and southern latitudes. Note that CH2 requires more than two positions in a HAC file 
for the following echointegration functions: to echointegrate along a grid where the steps are 
defined in distance intervals, to compute the step distance intervals in al1 echointegration modes, 
and to correct for the PC clock offset in computing and reporting the echointegration results (see 
section 8.6.3). 

Many rnacros are available through the various buttons above the Excel worksheet. The 
upper row of rnacros is to perform editing operations (Figure 8-15), while the lower row is to 
build a series of graphs to check for errors in the position series (Figure 8-16). An editing session 
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generally starts by an inspection of the data, i.e., by plotting a few graphs with the macros, such 
as the longitude, latitude, course or speed graph, to see the evolution of these variables in over 
time. These graphs will be generated in the upper window split of the worksheet Data page, one 
at a time. To see al1 the graphs simultaneously, an Al1 Graph macro can be used to generate them 
on the worksheet Graph page (e.g., Figure 8-16). When the inspection of the graphs reveals 
anomalies, such as outliers, duplicate positions, stepping courses or noisy positions, the rnacros 
are used to edit the enoneous positions. 

Figure 8-15. Editladd positions via Excel tool: Edition macros and worksheet organisation. 

Some editing rnacros, such as the various outliers' rnacros, must be applied in order. It is 
recornmended to start by removing duplicate positions if the file contains any. The Duplicated 
Lines macro is called to remove al1 rows in which the CPU and GPS times and position co- 
ordinates are repeated from the preceding row. 

Positions can be deleted by deleting the selected rows with the Excel Edit menu or by 
using the rnacros. When rows are deleted, the computed colurnns, such as the distance or the 
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L-d Draws a speed graph t = - .  

Figure 8-16. Editladd positions via Excel tool: Graph rnacros and al1 graph worksheet 1 :  
page- 

speed between positions, must be updated before computing new graphs. This is done using the 
Speed Calc. (ORIG) and Speed Calc. (PRED) rnacros. 

The Current Position rnacro offers three possibilities to edit the position CO-ordinates on 
which the pointer is located. The position CO-ordinate(s) can be either deleted, which will delete 
the row, or estimated using an average on a symmetric window of neighbouring positions (Figure 
8-17) or a linear regression on a given range of positions (Figure 8-18). The estimation can be 
done on both latitude and longitude at the same time or on only one of the CO-ordinates. It can be 
done using either the GPS time or the CPU time as the reference for the interpolation, as 
determined by the Time Ref rnacro (Figure 8-19). The predicted CO-ordinate(s) replace(s) the 
measured ones only when the Apply macro is called, which is usually done after al1 erroneous 
positions are estimated. The predicted CO-ordinates can be used to compute predicted speeds 
from the Speed Calc. (PRED) rnacro. Any new graph that is plotted when predicted values are 
present in the various predicted columns (columns X, Y, Z, AF to AJ) will include both data 
series, the observed (blue) and the predicted data (magenta). The computation of new predicted 
values will then update the predicted data series. 
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The Current Position rnacro can be called directly by pointing on a given position on the 
graph displayed on the worksheet data page. First select the graph data series by pointing on the 
plot. When the data series is selected, you can see in a ToolTip the data corresponding to the 
pointer position. By clicking on this point the CO-ordinates of the corresponding position are 
selected and the Current Position rnacro is called to edit the position. This is an easy way to find 
and edit outliers in the series. The graph is automatically updated when the position is changed, 
using the Apply rnacro. 

Figure 8-17. Edit/add positions via Excel tool: Current Position rnacro, editing a position 
longitude using a moving average on two neighbours before and after the 
selected position. 

The Smooth rnacro and the Mobile regression macro work similarly to the Current 
Position rnacro, but on the whole data series instead of a single position. The Smooth rnacro 
performs a mobile average using the given window width while the Mobile regression rnacro 
computes predicted values from a regression using the time reference selected from the Time Ref 
rnacro (Figure 8-19). This latter method may be preferable when the positions were recorded at 
irregular time intervals or when gaps occurred in the time series. At both ends of the data series, 



the positions corresponding to the half width of the mobile window are estimated from linear 
extrapolation from the first or last complete window. The graph rnacros can be used to examine 
the predicted values compared to the original data. The Apply rnacro replaces the original co- 
ordinates with the predicted ones. 

Figure 8-18. Editladd positions via Excel tool: Current Position rnacro, editing a position 
latitude using a regression on a window of four neighbours before and after 
the selected position. 

The outlier rnacros are specialised tools for locating and editing ouliers. The OUTliers 
rnacro detects the CO-ordinates that exceed a given number of standard deviations from the mean 
(Figure 8-21). The corresponding rows are tagged with a yellow background. The UntagOUT 
rnacro untags the outlier rows. The DelOUT macro deletes the outlier positions and updates the 
computed columns. The RegOUT and the SmoothOUT rnacros work like the similar functions of 
the Current Position rnacro described above. The ClearOUT rnacro clears the ce11 co-ordinates of 
the outlier positions. This is a prerequisite step before using the Mobile regression or the Smooth 
rnacros for filtering the whole position time series. One must take care not to define a mobile 
window that is smaller than the data gaps created by the ClearOUT rnacro. The Apply rnacro 
finalises the outlier editing. 
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When the position editing or addition is done, activate CH2 from the Windows menu bar 
and click on the Retrieve-positions button of the dialog box to upload the positions into the HAC 
file. Lf no editing was done, click on cancel to close Excel and return to the CH2 menus. Data 
from al1 rows are then checked with the original Position tuples for position editing changes, 
additions, or deletions. If necessary, new Position tuples are added and an Edition tuple defining 
which original Position tuples were edited is created. Following the CH2 approach, none of the 
original data is changed. A new Edit position operation is added to the Operation and Undo lists. 

Figure 8-19. Edit/add positions via Excel tool: Time Ref macro used to determine the time 
reference to produce the graphs and to estimate the corrected values with the 
edition macros. The example is of a speed graph, indicating noisy position data, 
which is computed using the GPS time as reference. 
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Figure 8-20. Ediiladd positions via Excel tool: Mobile Regression macro, using a half 
window of five neighbour positions to predict the new position and to fil1 out 
the predicted value columns. The speed graph plots both the original and the 
predicted values. 
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Figure 8-21. Edit/add positions via Excel tool: Find and tag outliers macro. 
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8.6 Tools 1 Echointegration ff cl' 

This tool is for computing the mean backscattering volume coefficient (s,) or the area 
backscattering coefficient (sa) per Echo category for one or many channels over horizontal and 
vertical integration grids. The horizontal echointegration steps can be defined in number of pings, 
time, or distance intervals. Unlirnited bottom- and surface-locked vertical depth strata series can 
be created and they are allowed to overlap. Clicking on the Echointegration tool opens a four-tab 
dialog box, which presents the parameters of the echointegration setup (Figure 8-22). 

Figure 8-22. Echointegration dialog box, General tab. 



8.6.1 General tab 

The first tab is used to define the echointegration output file name(s) and location, the 
type of echointegration data, the echo categories, and to change the average sound speed of the 
medium if required. CH2 can generate several echointegration files in a single process (Figure 8- 
23), one file for each combination of channel and b l ~ c k  of runs (see section 8.6.3). First, choose 
a root name for the hydroacoustic echointegration (*.hei) output file(s). By default, the root is the 
active HAC file name. CH2 adds the channel number (e.g., CO) and the block number (e.g., b l )  to 
the root name, and the file extension (.hei). The list of the related files of the echointegration 
process is given in the *.hei header. Type the directory name where you want to Save the *.hei 

MULTICHANNEL MULTICHANNEL !t: k-1 ACQUISITION 1 
can be subdivided into 

subjectively- labeled andior objectively- classed 
MULTICHANNEL 
INTEGRATION 

Echoinl gration HEI file 1 
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. . . . . . . . 

HE1 file ... 
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. . . . . . . . 

HE1 file ... 
Run block 1 

channe" 4 ~atyl 1 
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L./-' 
HE1 file ... 

HE1 file 2 
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category 2 n 
HE1 file ... 
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HE1 file ... 
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Figure 8-23. Structure of *.hei echointegration files output by CH2. 
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file(s) or choose it with the ". . . " button. The default is the directory of the active HAC file. If this 
field is blank, the Windows default directory (the last one you have used) will be used. The next 
field is used to Save a remark that will appear in the *.hei file header for this echointegration 
process. 

The Integration data type radio buttons serve to choose the type of data output you want 
to compute over the integration grid. Two choices are available: the mean volume backscattering 
coefficient s, (MVBS, m2 per m3, linear units, see Mac Lennan and Fernandez 2000) or the mean 
area backscattering coefficient s, (m2 per m2, linear units, ibid.). The choice you make is stored 
in the *.hei file header(s). 

The Echo Categories combo box presents a list of echo categories you can select for 
computing echointegration results. Each category is presented separately in the *.hei file (Figure 
8-23, Annex 1). The number of categories and their respective name(s) is (are) given in the *.hei 
file header (Annex 1). The displayed categories in the Echo category field come from a 
combination of the Echo category list (see Edit 1 Echo category list menu, section 6.4), except 
for the special Bad data and Exclude categories, and the loaded echointegration parameter (*.eip) 
file (section 8.6.5). The Echo category list is stored in the ~indows95/98@ registry of the PC in 
the present version of CH2. The Unclassified Echo category is automatically added to the 
displayed categories. This category corresponds to al1 echoes that have not been included in any 
Echo category, whether the categories are active or not. Check the echo categories for which you 
want to get separate echointegration results. Note that the categories loaded from an *.eip file are 
already checked. Uncheck them if you do xot want to include them in the integration. Note also 
that when checked echo categories overlap on the echogram, the overlapping echoes are 
integrated in each category, unless it is the Bad data category. This category is handled as 
missing data by CH2. The portions of the echogram tagged as Bad data (e.g., Figures 8-3 1 and 8- 
32) are simply ignored by the echointegration algorithm as if they had not been sampled. The 
Exclude category has a different meaning and is handled differently. The signals excluded in the 
echogram regions for which an Exclude operation has been performed are considered to be zero 
(i.e., below the value of the TVT) by the echointegration algorithm. For example, perfonning an 
Exclude operation for al1 signals smaller than the pulse length on the whole echogram is 
equivalent to setting al1 those excluded samples to zero for the echointegration function. 
Warning: It is important to clearly understand the differences between the two special echo 
categories, Bad data and Exclude, in the computation of the echointegration results. 

The Minimum sampled fraction of grid ce11 to echointegrate field quantifies the minimum 
stratum fraction of the echointegration grid ce11 that must have been sampled to compute an 
echointegration value. By default, the fraction is set to 10%. The user can change it by typing 
another value, including zero, in which case no minimum is considered. This CH2 option 
prevents spurious echointegration results in certain cells of the echointegration grid, for example 
cells that were poorly sampled, such as a surface-locked depth strata in which the bottom is 
intruding close to its starting depth or depth strata for which a large proportion has been declared 
missing by a Bad data classification. Note that CH2 does not take this Minimum sampled 
fraction into account in computinp the echointegration results of the automatic Whole water 
column depth strata of al1 *.hei files. The objective here is to produce the best estimate with al1 
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the information available over the whole sampled water column depth strata, for which the 
Minimum sampled fraction to echointegrate is rarely relevant. In the *.hei files, the 
echointegration results for the grid cells where the Minimum sarnpled fraction is not satisfied are 
set to the code given in the Echointegration ce11 coding for Missing Value field. CH2 uses 
"NaN" (for Not a Number) by default for coding echointegration missing values. 

The next field is the sound speed to use for echointegration. The sound speed recorded in 
the HAC data file is the default. CH2 allows the user to change it for the echointegration process 
by typing a new value in the editable Echointegration field. The present version of CH2 uses a 
constant sound speed to compute the range from the transducer. Subsequent versions will include 
an option to use a profile instead of an average for the sound speed and the absorption 
coefficient. The sound speed is involved in many parts of the echointegration process. It is used 
to determine the echo sarnple depth, the detected bottom depth, the TVG correction, the 
echointegration constant and the Fernandez and Sirnmonds' (1996) correction when selected. 
The effect of the sound speed in correcting the TVG and the echointegration constant is detailed 
in the Integration section (8.6.6) and Annex 2. 

8.6.2 Channel tab 

This tab is to choose the channel(s) to integrate for the echo categories selected in the 
general tab, to accept or modi@ their default values for echointegration, and to determine an 
optional echointegration threshold (Figure 8-24). The Channel to integrate combo box presents a 
list of the HAC data channel(s) that can be used for computing echointegration results. Only 20 
log R volts or Sv channels are available for echointegration. Al1 channels are selected by default. 
Uncheck the ones not wanted for computation of echointegration results. The values of the 
parameters corresponding to the active channel in the combo box are displayed in the series of 
fields of the dialog box. The parameters displayed depend on the type of echosounder used. The 
parameters differ between the analog Biosonics type and the EK500. Refer to the C H I  manual 
(Simard et al. 1998) or the HAC format description (Simard et al. 1997) for the parameter 
definitions. The HAC data file default values are displayed in the grey fields of the Original 
(HAC file) column. If necessary, use the editable fields of the Echointegration column to change 
these values for echointegration. If the echosounder is an analog Biosonics type, the Beam 
pattern factor (BPF) and Directivity index (DI) fields are displayed. Those two fields work 

DU10 together according to the following equation: BPF = -10 . CH2 uses the linear-scale beam 
pattern factor parameter. If you only know the alternative directivity index parameter in dB and 
you want to change its value, enter the new value in the corresponding editable field and the 
Beam pattern field will be changed automatically. The conversion can also be done in the other 
direction (BPF to DI). If the data came from an EK500 echosounder, two additional fields are 
given for applying a range-dependent correction necessary to offset a systematic error introduced 
during the calibration of older versions (5 ver. 5.2) of the EK500 (Fernandez and Simmonds, 
1996) (see section 8.6.6). The two parameters of the correction are the EK500 Receiver delay 
(milliseconds) (tdei of Fernandes and Simmonds 1996) and the EK500 Measured range to sphere 
at calibration (metres) (r, of Fernandes and Simmonds 1996). The EK500 measured range to the 
sphere differed from the true range to the sphere (r,,h) because of the receiver delay. Enter the 
values of these two parameters in the corresponding fields, if necessaIy. The next two parameters 



are the Installation depth of the transducer and the Blanking range. The default value for the 
blanking range comes from the echosounder tuple of the HAC file for the analog Biosonics type 
of echosounder. For EK500 data, the default value is set to zero because the blanking range used 
in the CHI Channel menu is not presently saved in the HAC file. The sum of the Installation 
depth of the transducer and the Blanking range give the Minimum sampled depth, within which 
no echointegration can be performed, for both surface-locked or bottom-locked depth strata (see 
sections 8.6.4 and 8.6.6, Figures 8-31 and 8-32). The last parameter is the Echointegration 
threshold (Sv in dB), which sets a threshold for including any echo sample in computing the 
echointegration results. By default no Echointegration threshold is used in CH2 by setting this 
parameter to an extremely low value (-200 dB). 
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8.6.3 Step tab 

This tab is used to define the horizontal axis of the echointegration grid and the series of 
mns to be grouped into separate blocks (e.g., Figures 8-25 and 8-26) for the computation of the 
echointegration results. The Echointegration block field is used to group the Runs of the HAC 
file (if it contains more than one Run) into series or Blocks (Figure 8-26) for which 
echointegration results will be computed and separate *.hei files created. CH2 generates one 
*.hei file per Block and Channel combination (Figure 8-23). The block number is indicated in the 
*.hei file header as well as the total number of Blocks and their associated file names that are 
involved in the whole echointegration process (see Annex 1). By default, the Echointegration 

Figure 8-25. Echointegration dialog box, Step tab. 
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block field contains a single Block grouping al1 the Runs of the HAC file. The loading of an *.eip 
file (see section 8.6.6) does not update that default configuration because different files generally 
contain different numbers of Runs. Use the New block, Edit, and Delete buttons to define your 
echointegration blocks if the HAC file contains more than one Run. Note that the Block of runs 
setting is saved in the echointegration parameter *.eip file, even though it is not applied at 
loading. 

A check-box is then presented to adjust the CPU clock time relative to GPS time from the 
times fields of the Position tuples of the HAC file. Warning: By default, this option is checked. 
CH2 automatically corrects for the most frequent offset of the PC dock relative to the GPS time, 

DISTANCE OR TlME 

BLOCK 1 = RUN 1 + RUN2 BLOCK 2 = RUN 3 + 
1 echointegration 1 - 

I 1 1 I '  t I . . . . . . . 1 Tirne start of 1 1 Time start of 1 1 Time start of 1 1 %  

Figure 8-26. Timelspace structure of multiple-Run HAC files and echointegration Blocks. 
Echointegration steps are defined by ping number. Note that the step limit 
sequence is bounded by the Run limits (Le., no run-overlapping step) and that 
the step widths vary when some pings are missing. 
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up to an offset of 30 min, unless this CPU time synchronisation option is unchecked. The Time 
offset of PC clock is computed from the most frequent PC clock time difference with GMT (in 
seconds) in al1 Position tuples of the HAC file, which is robust to outliers that could result from 
GPS bad data. The offset is the modulo 1800 of this time difference (i.e., in ~ x c e l @  formulation: 
MOD(most frequent PC time difference with GMT, 1800)). Therefore, if the CPU clock was not 
accurately adjusted at data acquisition, the times indicated for the echointegration steps in the 
*.hei file(s) are not the times you get by pointing on the echogram, but the corrected time. This is 
needed to properly align the echointegration results for further processing of the data, such as 
when they were collected by different PCs or to synchronise the results with other types of data 
recorded at the same time. The computed CPU time offset is reported in the Time offset of PC 

. . . . . . . 
Time start of Tirne start of Time start of 

Figure 8-27. Timelspace structure of multiple-Run HAC files, and echointegration blocks. 
Echointegration steps are defined in time or distance intervals. Note that steps 
can overlap two Runs and that both intra-Run and inter-Run empty steps can 
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clock field of the *.hei file. Note that if the HAC file has less than two GPS positions, the time 
correction will not be applied. 

The next group of fields serve to determine the echointegration steps in either ping, time, 
or distance intervals. If the active HAC file contains less than two GPS positions; the distance 
mode is not available; the Missing Value code will be reported for al1 columns of the *.hei file(s) 
in which the positions are involved (latitude, longitude, x-Lambert, y-Lambert, step distance, 
cumulative distance, sailing speed, step-distance weighted s, or sa results summary for the whole 
block). Use the radio buttons in the Units sub-group to make the choice, then give the 
corresponding interval in the field box. Time intervals can be given in minutes and seconds, 
which must be separated by colons. If there are no colons, CH2 reads the interval as seconds. The 
distance interval is given in metres (resolution 0.1 metre). If you choose to integrate in time 
intervals, an additional option becomes available in the adjacent check-box. Check this box if 
you want to align your time steps on a given minute:second of the hour. By default, this option is 
not checked. This option is required to properly align multi-echosounder or multi-channel 
echointegration results. For multiple-Run echointegration Blocks, the echointegration step series 
continue in between the Runs (see Figure 8-27) when they are defined in time or distance 
intervals. This is not the case when the steps are defined by number of pings, in which case a new 
step is starting at every Run (see Figure 8-26). 

b 

The last group of the step tab of the Echointegration dialog box is for defining the 
parameters of a Cartesian CO-ordinate system for calculating the starting CO-ordinates of your 
echointegration steps produced in the *.hei file(s), if the active HAC file has more than two 
positions. Cartesian CO-ordinates are needed for processing the echointegration data in a 
geostatistical framework or simply to produce non-deformed spatial plots of the echointegration 
results. These Cartesian CO-ordinates (metres by default) are computed from a Lambert 
projection. The user must define, in the appropriate fields at the bottom of this dialog box: the 
origin CO-ordinates and the optimal domain (between the two reference latitudes) for that 
Lambert projection. Use negatives for western longitudes and southern latitudes. The default 
earth radius (m) is given. If you choose to express the earth radius in other units (e.g., km), the 
Cartesian CO-ordinates and the distances in the *.hei files will be expressed in these new units. 
Warning: This change of units will also change the sailing speed units, which will be undefined, 
i.e., not knots (see section 8.6.5). Note also that the *.hei file will report the Missing Value code 
if the Cartesian CO-ordinates cannot be computed because the HAC file does not contain more 
than two GPS positions. 
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8.6.4 Depth strata tub 

The last tab of the 
Echointegration dialog box is used to 
define the vertical axis of the 
echointegration grid, with depth strata 
(or layers) referenced from the surface 
or the bottom (Figure 8-30). The two 
boxes and their associated buttons serve 
to define the series of surface- and 
bottom-locked depth strata (see Figures 
8-28 and 8-29) for which 
echointegration results are to be 
computed. To create a depth strata 
series, click on the New series button to 
open the dialog box to define the depth 
strata limits (Figure 8-28). Warning: 

Figure 8-28. Surface-locked strata definition dialog 

The surface depth strata are defined in the depth domaine (Le., distance from the surface) and 
not as range from the transducer. This depth reference is necessary to allow the comparing or 
merging of multi-channel echointegration results coming from HAC data acquired from 
transducers deployed at different depths. First determine the start and end depths for the depth 
strata series. Then the user chooses either the number of depth strata he wants to have over that 
depth range or the stratum thickness. The Update button computes the alternative field. The 
maximum resolution allowed for the , 
depth strata limits is 1 mm. Click on the 
OK button to return to the main dialog 
box. Repeat these steps to add other 
depth strata series. The various series of 
depth strata can overlap. For example, 
you can define a first series of ten 10-m 
depth strata from O to 100-m in the 
water column, followed by a series of 
four 25-m depth strata over the same O 
to 100-m depth range. A Whole water 

every selected Echo category over the 
whole sampled water column, from the 
Minimum sampled depth down to the bottom. The user does not have to define this stratum. 
Warning: The start depth of any depth strata within which the Minimum sampled depth (see 
section 8.6.2) for the corresponding channel(s) is located will be the Minimum sampled depth in 
the *.hei file(s). The echointegration start depth then becomes the sum of the Installation depth of 
the transducer and the Blanking range. These latter parameters are channel specific and therefore 

column stratum is automatically 
included by CH2 in al1 *.hei files to 
compute echointegration results for 
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Figure 8-29. Bottom-locked strata definition 
dialog box. 



can Vary among channels. Similarly, the definition of the bottom-locked depth strata series is 
made by clicking on the corresponding New series button. The depth strata limits are given in 
height (altitude) above the bottom. The echointegration stops at the Minimum sampled depth. 

8.6.5 Updating, saving, and loading echoirztegration setting parameters 

The OK button at the bottom of the Echointegration dialog box updates the fields of the 
four tabs of the dialog box, so that the updated values will be recalled by CH2 the next time the 
Echointegration tool is called up. The Save As button and the Integrate button defined below also 
have the effect of updating the echointegration setting parameters. Warning: If one quits the 
Echointegration dialog box by clicking on the Cancel button or the standard Windows closing X 
at the top right of the dialog box the changes made to the fields will not be saved and the default 
setting parameter values will be used the next time Echointegration tool is called up. 



If the user wants to re-use the echointegration parameter settings frequently, he can Save 
them in an echointegration parameter *.eip file using the Save As button. This ASCII file can be 
edited with a text editor. The Load button loads the parameter settings in the Echointegration 
dialog box. Note that these *.eip files Vary with echosounder type, as they require specific 
parameters. The user should not forget to edit the pararneter settings he wants to change before 
integrating, notably the output *.hei file narne if you do not want to use the default HAC file 
name as the *.hei root narne. Note that the setting of the echointegration Block(s) is saved in the 
*.eip file, but it is not applied at loading because the number of runs usually varies from file to 
file. The default Block setting is one Block containing al1 the runs of the active HAC file. 

When an *.eip file is loaded, the Echo categories it contains are added to the list 
displayed in the first tab of the Echointegration dialog box, if these categories are not already 
listed (from the active categories in the Echo category list), and their check box is checked, i.e., 
active. If the *.eip file contains categories that are not included in CH2 Echo category list, these 
categories are added to the CH2 list. Warning: CH2 checks for the sirnilarity in the character 
string of the Echo categoq names of the *.eip file and the Echo category list. In this case, the 
comparison is not case sensitive (i.e., "Herring" is the same as "herring") as opposed to the 
creation of Echo categories (see section 6.4). Special attention should be paid to the spelling of 
Echo category names, which could result in duplicated Echo categories (e.g., "caplin" and 
"capelin" would be two different categories for CH2). 

8.6.6 Zntegration 

Finally, click on the Integrate button to echointegrate and produce the *.hei filets). A 
progress box will appear to monitor the creation of each *.hei file of the echointegration process. 
Many *.hei files may be generated during echointegration, one for every combination of channel 
and echointegration Block (see Figure 8-23). These *.hei echointegration files are tab-delimited 
ASCII text files that can be opened directly by worksheet applications such as ~ x c e l @  or other 
packages. The *.hei file format is given in the HEI-format-verl.3.xls Excel file supplied with 
CH2 (see Annex 1). The *.hei files contain a long metadata header that describes the 
echointegration pararneter and grid settings, followed by the echointegration results for each echo 
category that was selected in the General tab of the echointegration dialog box. 
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Figure 8-31. Echointegration grid with surface-locked depth strata. The strata limits are given in 
depth from the surface, not in range from the transducer. The blanking range at the 
top is added to the transducer installation depth to set the minimum sampled depth, 
indicated by the horizontal bold line limiting the start depth of the upper stratum. Al1 
the other strata limits are still referred to the starting depth of the strata series, not to 
the minimum sampled depth. The minimum sampled depth can be set at any other 
depth by changing the Blanking range andlor the Installation depth of transducer in 
the Channel tab of the Echointegration dialog box. Any echo sample shallower than 
the minimum sampled depth is ignored (Le., non existent) for the echointegration. 
Grid ce11 #1 is a normal pelagic cell, entirely sampled. Grid ceIl #2 is a bottom cell, 
partially sampled because the bottom is intruding. Grid ce11 #3 is a partially sampled 
pelagic cell because a portion that contains bad data is considered unsampled. The 
two grid cells #4 have a very small sampled fraction, which may be considered 
below the Minimum sampled fraction to echointegrate. Grid ce11 #5 is partially 
sampled because it is in a stratum where the start depth is defined by the minimum 
sampled depth. This minimum sampled depth could be set to another depth in the 
Channel tab. Al1 strata shallower than this depth will be considered unsampled for 
echointegration. 
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Figure 8-32. Echointegration grid with bottom-locked depth strata. Strata limits are referred to the 
detected (or edited) bottom depth. Note the blanking range at the top, which is added 
to the transducer installation depth to set the minimum sampled depth indicated by 
the horizontal bold line limiting the upper bottom-locked strata for echointegration. 
This minimum sampled depth can be set at any other depth by changing the Blanking 
range or the Installation depth of transducer in the Channel tab of the Echointegration 
dialog box. Any echo sample and strata shallower than the minimum sampled depth 
is ignored (i.e., non existent) for echointegration. Grid ce11 #1 is a normal pelagic 
cell, entirely sampled. Grid ce11 #2 is a partially sampled surface ce11 becausc the 
minimum sampled depth is intruding. Grid ce11 #3 is a partially sampled pelagic ce11 
because a portion that contains bad data is considered unsampled. The two grid cells 
#4 have a very small sampled fraction, which may be considered below the Minimum 
sampled fraction to echointegrate. 
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For surface depth strata, the echointegration is computed from the minimum sampled 
depth down to the strata end depth or to the Detected bottom sarnple for the depth strata touching 
the bottom (see Figure 8-3 1). For bottom-locked depth strata, the echointegration is performed up 
to the strata end heights or to the minimum sampled depth for the depth strata,that contains this 
depth (see Figure 8-32). For both types of depth strata, the echo sarnple corresponding to the start 
limit is included in the stratum and the echo sample corresponding to the end limit is excluded. 
In a depth strata series, the end sample is the same as the start sample of the next depth strata in 
the series, and is therefore counted only once. The Detected bottom sample is never included and 
the Minimum sampled depth sample is always included. The echointegration results are set to the 
Missing Value code in the *.hei files for al1 bottom-locked depth strata shallower than the 
minimum sampled depth and surface-locked depth strata deeper than the bottom. Empty depth 
strata resulting from the classification of an area as Bad data (e.g., Figure 8-31) are also set to 
Missing Value code. Bottom-lost pings are ignored for echointegration. To include these 
bottom-lost pings in the integration, add a detected bottom with one of the CH2 bottom editing 
tools. Entire steps can sometimes be empty, if they were classified as Bad data, are located in 
between two runs (e.g., Figure 8-27), or if the detected bottom is below the minimum sampled 
depth. In such cases al1 depth strata of the given ping are set to Missing Value code. When the 
step interval is in pings and the integration Block(s) contain(s) more than one run, the last step 
of each run is closed by the last pings of the given run and a new step begins at the next run 
(Figure 8-26). Therefore, in ping interval mode, steps do not overlap from one run to the other. 

The echointegration results for each ce11 of the echointegration grid are computed as 
follows. If the echo sample units of the HAC data file are volts, as it is generally the case for the 
20 log R TVG detected signal of the analog type of echosounders, voltages (Vm) are first 
converted to volume backscattering coefficient s, (m2 per m3, linear units). Often, this 
backscattering intensity index is also named MVBS (mean volume backscattering strength) in 
fisheries acoustics literature. When the unit of the echo sample is the volume backscattering 
strength, Sv in dB re lm-', the volume backscattering coefficient, s,, is obtained from the 

conversion: sv = 10 The equations for the grid ce11 are: 

1 2 
Sv (grid cell) = C V ~ / G  A 

1 
Sv (,qrid cell) = - C Sv 

n 

where nd,, is the number of detected echo samples whose voltage exceeds the value of the time 
varied threshold at the given range and I I  is the maximum number of echo samples that could be 



sampled in the grid cell. The fraction of the ce11 that cannot be sampled because the bottom (or 
minimum sampled depth) is intmding into the cell, or because a part of the ce11 has been tagged 
as bad data, is excluded from the computation of n. The constant A is the calibration constant 
(also named echointegration constant). It is computed from the equation: 

Its parameters (in SI units) are: the pulse duration, z (s); the sound speed at range O, co (m s-'); the 
source level, SL (dB re 1 pPa @ 1 m); the receiving sensitivity, RS (dB re 1 V); and the bearn 
pattern factor, BPF (unitless). For the EK500, the s, is expressed differently since Simrad used 
the formulation of the radar equation instead of the sonar equation used in acoustics. 

where P, and Pr are respectively the received and the transrnitted power; Go is the one-way fixed 
gain, whose dB equivalent is the Sv transducer gain (10 loglo G); h is the sound wavelength (m); 
y i s  the equivalent beam angle in steradians, called the two-way beam angle (in dB: 1 0  loglo y); 
and GWc is the 20 log R TVG. For circular transducers y = BPF 2 iz, approximately (Urick 
1983). The total two-way gain (G') in dB is 20 log10 G. 

The above calibration parameters come from the Channel and Echosounder tuples of the 
HAC data files, unless they were changed in the General andlor the Channel tabs of the 
echointegration dialog box (sections 8.6.1 and 8.6.2). In that case the range of the echo samples 
and of the detected bottom is updated using the new sound speed, and the time-varied gain 
(GwC) is corrected for the change in sound speed and the absorption coefficient. For the 
Biosonics type analog echosounder, the constant A is computed using the new parameters when 
the echo samples are in volts. When the echo samples are in S, units, a correction is applied. The 
equations are: 

for the Biosonics type analog echosounder: 

- V 2  G7VG2 
- 7VGl A2 ,  for echo samples in volts 

Sv2 = S v 1  GTvG2 *, for echo samples in S, 
GTVG~ Ai 



for the EK500 echosounder: 
?. 

where the indices 1 and 2 are, respectively, for logging at acquisition and processing for 
echointegration. The range-dependent GWG correction, AGwGrz, adjusting the TVG to the 
characteristics of the propagation medium is given by: 

where r2 = r, 2 
Cl 

where b is the absorption coefficient in nepers m-', computed from the absorption coefficient a 
in dB km-' of the HAC Channel tuple (b = (a /  1000) 1 10 loglo e). 

The correction related to changes of source level, pulse duration, sound speed at 
range O, receiving sensitivity, and beam pattern is not range dependent and is given by: 

for the Biosonics type analog echosounder: 

4 
Sv:! =Sv1 a- 

4 

(il ri cO2 1 0 ~ " ~  10Rs2110 BPF2) 
Sv2 =Sv1 1 

for the EK500 echosounder: 

Co G,' 
S , ,  =si., .--.--.- 

G22 y:! 
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where the SL, RS, Sv transducer gain and the two-way beam angle are in dB. As mentioned in 
section 8.1, in this version of CH2, the medium is assumed homogeneous and the sound speed is 
the same at al1 ranges (i.e., CO = c). For the EK500, there is no correction of the pulse duration 
since it is not applicable. The EK.500 computes the Sv using the right pulse duration 
corresponding to the nominal pulse lengths chosen by the user at acquisition. In the case of 
Biosonics-type analog echosounders, the pulse duration is indicated by the user at acquisition 
with CHI and could be changed later to compute the right s, if the value stored in the HAC data 
file was wrong. 

In the case of the EK.500, an additional correction could be applied to s,,~ to take into 
account a systematic error occurring during calibration in early versions (2 ver. 5.2) of the 
EK500 (Fernandez and Simmonds, 1996). This error relates to an inaccurate estimation of the 
range to the target, because the receiver delay was ignored, and to an improper TVG start time 
over the pulse length. The range-dependent correction factor from equation 8 of Fernandez and 
Simmonds (1996), is called correction for receiver delay and TVG start time delay. The 

equations are: 

where: rsph = rnl - (',a/ tdel) 
2 

( c r u /  tg ) z ArK = , where t, =t,, +- 
2 2 

The above equation is a simplification of Fernandez and Simmonds' (1996) equation 8, which 
retains only the significant range terms. In Fernandez and Simmonds' (1996) notation, r, (m) is 
the range measured on the EK500 to the calibration sphere, r,,h (m) is the actual range to the 
calibration sphere, and tdel (s) is the receiver delay. cc,, is the sound speed at calibration, which is 
assumed to be equal to CO in this version of CH2. The pulse duration (7) used by CH2 for 
computing the Fernandez and Simmonds' (1996) correction is the one corresponding to the 
"medium" nominal pulse length recommended by Sirnrad for the EK500 calibration. These pulse 



durations vâry with frequency as follows: 12 kHz, 3.0 ms; 18 kHz, 2.0 ms; 27 kHz, 1.5 ms; 38 
kHz, 1 .O ms; 49 kHz, 1 .O ms; 120 kHz, 0.3 ms; 200 kHz, 0.2 ms. 

The area backscattering coefficient sa (unitless, m2 m-') for each ce11 of the echointegration 

grid is obtained from s, and the mean sampled height, h, (m), for that cell. This h, differs from 
the depth strata thickness in the grid cells where a fraction of the depth strata has not been 
sampled, either because the bottom or the minimum sampled depth is intruding into the strata. 
The general equation is: 

- 
Sa (grid cell) = hs (grid cell) Sv (grid cell) 

When a grid ce11 has not been sampled or the sampled fraction is less than the minimum sarnpled 
fraction of the grid ce11 to be echointegrated, then the SV or sa for this ce11 is assigned the Missing 
Value code. 

Besides the sa or s, results of each echointegration grid ce11 and Echo category, the *.hei 
file reports the number of pings, the starting CO-ordinates, the starting drift-corrected PC time, 
and the linear distance covered for each echointegration step (see section 8.6.3). The geographic 
CO-ordinates are interpolated from the GPS positions and ping times, or the start or end of mn 
times, of the original or edited tuples of the HAC file. The linear distance covered during the 
steps is the distance computed from the two limit points of the step. Note that this is not the 
cumulative distance resulting from the sum of the inter-ping distances plus the remaining 
segments up to the step limits. This latter distance would generally be in error, due to the 
summation of proportionally large errors in distance estimates between successive GPS positions 
recorded at relatively short time-space intervals. The starting Cartesian CO-ordinates and the 
linear step distances are given in metres although, as mentioned in section 8.6.3, they would be in 
other units if the earth radius of the Lambert projection was given in other units. This change of 
units would also affect the computed sailing speed (see below). The linear step distance (m) is 
then divided by the time interval of the step (s) and the result is divided by 0.5148 m s-' knots to 
get an estimate of the average sailing speed in knots for the step. The average bottom depth of the 
step is computed from the original or edited detected bottom range of the pings of the step, 
corrected for the eventual change in sound speed. 

An additional line of results follows the report of the echointegration step results for each 
Echo category (see Annex 1, description of the *.hei format). This line either terminates or 
summarises the colurnn results for the whole echointegration Block of runs and gives, in order, 
the end time and spatial CO-ordinates, the total number of pings, and the linear distance between 
the start and end limits of the Block. This distance can be compared with the cumulated distance 
obtained by surnrning the linear step distances (the adjacent field). Warning: Steps with no 
pings are ignored. In the case of multiple-run Blocks integrated in ping interval mode, the 
cumulated distance does not include the gaps between the runs (see Figure 8-26). Except for 
these cases, the step-cumulated distance should be longer than the linear distance for the Block, 
especially if the ship's course significantly deviated from a straight line. The step-cumulated 
distance is used with the next column field, the total time of the whole Block, to compute the 



mean sailing speed over the Block. The average bottom depth for the Block that follows is 
simply the average of the mean depths of the non-empty steps. Then the average s,, or sa for the 
whole Block for each depth strata and the whole water colurnn are computed from the step s, or 
sa weighted by the step distance. Since most echointegration processes are carried out to produce 
estimates over specific areas or volumes, the distance is the most relevant weighting variable. 
Subsequent versions of CH2 should allow the users to choose the weighting variable (ping, time, 
or distance). If the HAC file has less than two positions, the average s, or s, for the Whole block 
will not be computed and the Missing Value code will be reported. A Missing Value will also be 
reported in the Whole block line for any depth strata where a Missing Value was reported for al1 
steps. 

8.7 Tools 1 Options 

This menu sets the default options for CH2, specifically the view preferences in the present 
CH2 version. When an HAC data channel is opened, the echogram is displayed with its specific 

Figure 8-33. Tools/Options menu to set the echogram default view options. 
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Figure 8-34. Echogram with 20 runs with the Show TVT and the Show run's limits options 
activated. Note that the TVT editing or visualisation can be accessed by a right 
click on the mouse when pointing on a TVT icon. 

default view options, defined in the four tabs of the Tools 1 Options dialog box (Figure 8-33). 
The View 1 Properties menu (section 7-19) must be used to change the view option for the active 
echogram only. The General tab has two check-boxes offering the options to show the Run limits 
with a vertical black line and to display an icon where the TVTs are inserted (except the initial 
TVT at the beginning of the echogram) (Figure 8-34). The Palettes button accesses the dialog 
box showing the default palettes used by CH2 to display the echo sarnples in volts, Sv, or TS 
(dB), depending on the data channel (Figure 8-35). The Auxiliary palette is used to display al1 
other data channels. Note that palettes are echogram properties and can be changed at any time 
from the Edit 1 Palette menu (see section 6.1). Palettes can be stored in *.pal binary files and can 
be recalled using the Load button of the palette dialog box (Figure 8-35). The Default palettes 
can be edited from the Edit button, which calls the Palette editor dialog box (Figure 8-35, see 
section 6.1). 

The Tool 1 Options second tab parameters define the echogram X - a i s  default units and 
some display constraints. The echograms can be displayed with the ping sequence, time, or 
distance as the X - a i s  units. When Pings is selected, the user has the possibility to add two 
constraints to the viewing preferences: to display every ping and every echo sample. This is to 
insure that al1 pings and echo samples will be visible when scrolling through the echogram, not 
only those that the window size and pixel resolution allow to view. The Display every ping 
option is useful when checking the detected bottom depth. When Distance is selected, the 
additional option forcing the X- and Z-axes to the same scale is offered (keep 1:l aspect ratio) , 



which is useful for accurately visualising the shape of fish school vertical cross-sections. 
Warning: For this option works properly, the position data must be exempt of noise and the 
sailing speed must be a smooth function. 

The Tool 1 Options third tab parameters set the Z-axis default view mode (surface-lock or 
bottom-lock), the default view range or height above bottom according to the selected mode, and 
the height offset. Radio buttons set the default view mode to surface-lock or bottom-lock. A 
check-box then activates or deactivates a user-defined Default view range or height. In the 
unchecked case, the echograms are opened with the full view range or height. The values entered 
in the Minimum and Maximum range (or height) fields define the Default view range or height, 
which can be recalled through the View 1 Default view range menu or mouse right button (see 
section 7-9). When these two filed are put to zero, the Default view range or height becomes the 
full view range or height. When the Default view range or height check box is checked, al1 
echograms are opened with the Default view range or height defined by the Minimum and 
Maximum range (or height) fields. In the bottom-lock mode, an optional Height offset can be set 
for distancing the detected bottom from the echogram window bottom, for greater visibility of 
the bottom zone. When the Default view range or height check-box is not activated, the 
echograms are automatically displayed down to the maximum detected range (or up to the 
maximum height above bottom) unless the constraint to Display every sample is selected in the 
Display units tab. 

8 Tools Menu 
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Figure 8-35 Tools / Opiiois i Denera tiib Palette buiton to set the &iliIi palettes associated 1 
io the vasioiis channel data types. :;. 

Thc Tools 1 Options last tab check-boxes nctivatc or deactivate tlie hoi-izoiital and vertical 
scale display by defaiilt on tlie echogsains. The otlies pz~rarneterï configurc the disylay format. 
The veriicril tick interval is deterniined automatically by Cl12 as a Irziction of thc visualised range 
interval, which is the secommended opeiation mode. However, the LISCS can sct the tick intesval 
to a prefei~cd coiistant value. The tick mark size can be selected fsom the scsoll box. If he 
cliooses the AI1 option, continoous lines will be drawn on the ecliogiïim instead of a tick. The 
font and colour propesties of the tick label :ire deterniined h m  tlie Label font bution. The chosen 
scale options becoine the Cf12 defi~iilt scalc options by a click on tlic Set as delüult button. This 
dialog box is also accessible Ssom ihe Tools / Oprions menu. 

& Tools Mcnu 



9. UNDO/IREDO OPERATIONS 

Undo scroll box To undo a series of editing/classification operations starting from 
the selected operation from the scroll list. 

Redo scroll box To redo a series of editing/classification ending with a selected 
operation in the scroll list. 

The Undo and Redo operation functions are two of the main CH2 attributes for effective 
hydroacoustic data editing. Al1 the editing/classification operations done during an editing 
session or previously saved in an edited HAC file can be undone. Therefore, if the user has to 

Figure 9-1. ExampIe of the Undo function. The Undo scroll box lists al1 operations the HAC 
file contains. By selecting an operation from that list and releasing the mouse 
button, the operation is undone with al1 other subsequent operations, Here the two 
Classify operations, the Edit TVT and the Move bottom operations will be undone. 

I The undone operations are placed in the Redo list. 



modiQ the data processing for any reason, he can go back to any file editing state by using the 
Undo function. The Undo and Redo operation functions provide a convenient tool for exploring 
the effects of various editing operations. Since al1 the editing/classification operations are applied 
in sequence, some of them may require prerequisite operations to be applied before they 
themselves are applied. Inversely, the application of some operations can prevent the application 
of other subsequent operations. For exarnple, a Classi@ operation on a region for which an 
Exclude al1 signals operation has been perfomed has no interest. Because of these linlung 
conditions, this version of CH2 can only undo or redo the operations in the sequence they were 
initially performed. Subsequent versions should allow certain selected operations to be undone 
independently from within the Undo list. 

To undo the last operation or the last series of operations, scroll the Undo list and select 
the starting operation of the series and release the mouse button (Figure 9-1). The Undo list is 

Figure 9-2. Example of the Redo function. The Redo scroll box lists the undone operations 
that can be redone. By selecting an operation from that list and releasing the 
mouse button, the operation is redone with al1 other preceding operations. Here 
the Classify (Cod) and the Move bottom operations will be undone. The undone 
operations are placed in the Redo list. 



presented in the inverse order from which they were done, the last applied operations being at the 
top of the list. The channel numbers to which the operation applies is indicated in the brackets 
before the operation name. Al1 undone operations will be placed in the Redo operation list, in 
the sequence that they were initially created in. They will remain there until a new operation is 
applied, which will create a new applied operation sequence. This breaks the possibility to redo 
the undone operations, because of the above-mentioned linking conditions. The Redo operation 
list is thus erased when a new editing/classification operation is applied to the file. 

To redo an undone operations from the Redo list, scroll the list, select the last operation 
of the series to redo and release the mouse button (Figure 9-2). The Redo list presents the 
operations in the sequence they were done in, the first applied operations being at the top of the 
list. 

When CH2 saves an edited HAC file, only the tuples of the operations in the Undo list 
are appended to the file, the undone operations of the Redo list being ignored and erased from the 
list. 





10. WINDOW MENU 

10.1 Window / Cascade 

Overlays the channel windows. 

10.2 Window / Tile horizontal 

Tiles the channel windows horizontally. 

10.3 Window / Tile vertical 

Tiles the channel windows vertically. 

10.4 Window / Arrange icons 

Arranges the icons of the minimized channel windows. 

10.5 Window / List of open documents 

Lists the open HAC channel windows. The active one is marked. 

d Window Menu 





1 1  ERROR MESSAGES AND TROUBLESHOOTING 

11.1 HAC file errors 

The seven error checks of the File / File checking options menu (see section 5.9) are 
described below. Al1 these errors can be corrected by CH2, when a HAC file is opened and the 
File checking options manager and the respective error check-boxes are activated, or by the 
HAC-trafic File / File checking options 1 Fix utility. The correction results in the creation of a 
file-root-name.log file and a new HAC file with the "-corH characters added to the original root 
name. These files are stored in the Working directory chosen in the File checking option dialog 
box. 

11.1.1 Signature validation 

The Signature validation plugin checks for the presence of the HAC signature tuple and 
verifies the validity of its structure. If this test fails, the file is not a HAC file and its opening 
aborts after the message "Invalid HAC file: . . . " is displayed. 

11.1.2 Edition tuple integriîy 

The Edition tuple integrity plugin verifies the structural integrity of the other tuples in the 
file A specific error was produced in the Edition Tuple when the tuple-size field was incorrectly 
calculated by earlier versions of CH2 (before ver. 1.5). This plugin recalculates this field and 
replaces it in the Edition tuple. 

11.1.3 Pingorder 

The Ping order plugin checks for the continuous increase of the ping number within the 
file. The ping numbering could be out of ascending order in certain files created by CH1 
(previous to ver. 2.0) when the ping number reached 66536 (16 bits) and the following ping 
number was set to O. The plugin corrects this error by renumbering the pings, starting from the 
first ping of the file. 

11.1.4 Time synchronisation (second vs decirnal) 

The Time synchronisation (second vs decimal) plugin checks for the synchronisation of 
the seconds and the decimal fractions among ping tuples in EK500 HAC files. This error was 
produced by CH1 (previous to ver. 2.0) because the CPU time (hh:rnrn:ss) saved in the ping 
tuples was determined from the computer clock, and the fraction of a second was deterniined 
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from the EK500 ping telegram. Since these clocks were rarely synchronised, this sometimes 
produced a non-monotonic increase in the ping time stamp, especially if the ping rate was not a 
multiple of 1 second. The plugin corrects the error by reassigning the CPU time in each ping 
tuple according to the synchronised time interval between each ping. Since ver. 2.0 of CHI, the 
ping CPU time (hh:rnm:ss.dd) is determined entirely by the computer clock. 

11.1.5 Time variation (warning) 

The Time variation (warning) plugin checks for variations of more than 10% from the 
most frequent ping interval in the file and issues a warning. This may reveal an error in the file or 
the use of a variable ping rate at acquisition (e.g., EK500 option for maximum ping rate 
according to bottom depth). 

11.1.6 Pings within run limits 

The Pings within run lirnits plugin checks for the presence of pings outside of the Run 
limits indicated by the Start of run and End of run tuples of the HAC file. This error occurred 
because CH1 (previous to ver 2.0) was using two different methods for determining the CPU 
time for the Ping tuple and the Start of Run and End of Run tuples. The plugin corrects the error 
by reassigning the Start of Run andor End of Run tuple CPU time to the value of the time of the 
first andor last ping in the run, respectively, and the End of File tuple to the value of the last ping 
in the file. Since ver. 2.0 of CHI, the same method is used for determining CPU time for al1 
tuples. 

11.1.7 Old TVT equation used (warning) 

The Old TVT equation used (warning) plugin checks whether a previous (erroneous) 
equation was used by CHI for the estimation of the TVT offset and amplification parameters in 
the EK500 HAC files. If the old parameters are found, the parameters of the present TVT 
equation are estimated if the user accepts to correct this error (recommended), and the old TVT 
parameters are replaced in the TVT tuple, whose attribute field is coded as edited. 

11.2 GPS position 

11.2.1 X axis distance view mode 

Trouble: The echogram displays very broad pings when the X axis view mode is in 
distance. 

This occurs when some positions are in error. Correct the erroneous positions with the 
Ediuadd positions via Excel tool to correct this data problem. 

Troubleshooting 



11.2.2 X axis distance view mode with the keep 1:l aspect ratio option 

Trouble: The pings displayed on the echogram have highly variable widths. 

This results from noisy position data that were acquired with a high rate. The variable 
ping width reflects the position data error. Correct the positions by smoothing them to get a 
reasonable sailing speed with the Editladd positions via Excel tool, before using this keep 1:l 
aspect ratio option or the X axis distance view mode. 

11.2.3 Positions lacking 

Trouble: The echogram displays variable long pings when the X axis view mode is in 
distance. 

X axis distance view mode is not available nor is the echointegration option along 
distance steps. 

These options cannot be used when positions are lacking. Use the Editladd positions via 
Excel tool to add positions that CH2 can use to compute distances. 

11.3 Viewing classified or excluded regions 

11.3.1 Alignment of mask shapes over the selected echo samples 

Trouble: The colour-masked classified echo samples or the excluded echo samples do not 
correspond exactly to the mask shape superimposed on the classified or excluded region. 

If your echogram display mode is not Time, this could result from irregularities in the 
ping intervals in this region or gaps in the ping time series. Change the display mode for Time in 
the View / Properties or Tools 1 Options menus to show the exact location of the classified 
region. Note that CH2 computes the polygons and selects the echo samples in the time domain. 

11.3.2 Loss of the hatched region shape 

Trouble: The hatching of classified regions has disappeared and access to the 
characteristics of the operations for this region from the right mouse button is not available. 

The hatched shapes of classified or excluded regions are only visible in the display mode 
in which they were defined, either relative to the surface (surface-lock mode) or relative to the 
bottom (bottom-lock mode) . Change to the alternate display mode if you want to see the hatched 
shape and have access to the characteristics of the operations for this region from the right mouse 
button. - 
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14. ANNEX 1: The *.hei echointegration ASCII file format 



Table 1. Description of the *.hei ver 1.3 ASCIl file CH2 outputs for the echointegration results. 
Par i  of the file 1 Tag 1 Field description 1 ~ n t a  exnmple 1 Field description 1 Data example 

Sigiiature IHEI file signature 1 1 HE1 1 1 
Cornments 

HE1 = Hydroacoustic Echolntegration 1 
I I I I I I I 

~ H E I  version I H E I - ~ a t n  format version 1 1.3 1 Asheries & Oceans Canada. National 

!file (file 1 1 1 1 I 
IEdited source file IEdited file used for ~cree~9X-13-001eOl.h(i 1 IHAC file format 

1 1 lHydroacoustic Program 
GENERAL HEADER loriginal source loriginal raw data source 1 1 c r e e h 9 N 1 3 ~ 0 0 l . h ~ ~  1 ~ H A C  file format 1 

Integratioii 
software 
Software version 
, I I I I 

integration 
Integration software 

Version (of software) 

Rcmark 
I l l 

Kelated HE1 files 

l.;clio\oiiii<lcr tj1w 

I I 1 

cr-98-13-cl-h2.hei 
cr-9X13-cl-b3 hei 

c 
CH2 

2.0 

Remark 

Additional HE1 files 
correspondiiig to the otlier 
cl iann~ls aiicUor run hlocks 
of thî  soiirce file, 
\iiiiulianrou\ly 
r<li~~inicgratrt l  niih the 
I>"\"lt <>"" 

I:cl~oçoun~lcr type 
1 

Sound \pw11 

:$ Ip11:i 

Fisheries & Oceans Canada. National 
Hydroacoustic Program 
Version of November 2000. 

Sound speed of the (original 
o r  edited) Channel tuple (mis) 
Alplia of the (original o r  
edited) Channel tuple 

SI'I) profile 

an). conimenr 

Alpha & 
SS profile 

Froin the CH2 echointegration dialog box 

(dlllkm) 

Sound speed used for 
echointegration (nds) 
Alpha used for 
echointegration (dB/km) 

*NB: for the EK500, s o m  of the next lines 
of this *.hei file will contain information 

1473 

26.2 

I 

of CHZ, but could be implemented in iiie 
Ascii file of alpha & sound 
speed profile used for 
e~hoin te~ra t ion  (dBkm) 1 lfuture versions 
Ascii file of temperature and 1 T S D orn 1 

alpha-ssp03.prn 

salinity profile i sed  to 1 - -' ' 1 1 
1 1 1 1 1 1 compute alpha & sound speed 1 1 1 
I I I 1 I - I I I 1 profile used for 

Min. sampled 
fraction of grid 
cell to 
echoiiitegrate 

1 
I~ in imurn  fraction (96) of the grid cell that 
musi have been sampled for computing the s, 
or S.. Wherr the bottom or the minimum 
sarnpled depth is intruding in the cell or the 
"bad data" category ornupies a large 
proportion of it, the sampled fraction could 
beconr too low to compute a reliable 
estimate for this cell. 
In such a case, when the sainpled fraction is 
lower than the given percentage, the s, or S. 

will no1 be estiinaied for this cell and a 
Missing Value code will indicate a rnissing 

I 1 value. I . 



Table 1. Continued. 
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Commenb 
Code used by CH2 to repon ecliointegration 
niissing values for ecliointegration cells 
below the detected bottom. cells above ihe 
minimum sampled depth. celis with bad data, 
or cells where the sampled fraction was 
lower than the Min. sampled fraction of grid 
cell to echointegrate. By default CH2 uses 
the Missing Value code "NaN" (for Nol a 
Number). 
NB: ttiere is oiily one channel pet *.lrei 
ecliointegratio~i file. Multichaiinel 
echointegration results in many 
echointcgration files. 

Here the user has the possibility to integrate 
using paramters thnt are different from those 
of the (original or ediced) tuples of the HAC 
file. 

Field descriplion 

Pulse duration used for 
echointegration (ms) 

SL used for echointegration 
(dB) 

Ueam pattern factor (Bav' or 
BPF) of the (original or 
edited) Channel tuple 
Value of B square (linear): 
10 log(lA>eam pattern factor). 
Approximation for a circular 
transducer of active diameter 
d: Bav2 or BPF= (LI a d)' 

Directivity index (DI) 
corresponding to the beam 
pattern factor of the (original 
or edited) Channel tuple 
(10 log (Iheam pattern 
factor). Approximation for a 
circular transducer of active 
diameter 
d: Dl=l0 log ( a d  1 L)' 
Two-way heam angle (i.e., 10 
log y )  of the (original or 
edited) Channel tuple in dB 
for the EK500 

Dada example 
-9999.99 

01 

120 

0. 5 

221.5 

,0035 

24.56 

-26.7 

3.3 

l'art of the file Data example 

0.5 

225. 0 

,0035 

24.56 

-26.7 

3.3 

Tag 
Pkhointegration 
cell coding for 
Missing Values 

Channel no. 

Frequency 

I'ulse duration3 

Source leiel 

L%eairi pattern 
fsrlor 

1)irectivity index 

Two-way heam 
angle 

3-dB beamwidth 
alongship 

Field 

Channel 

description 

no. 

freq. (kHz) 

pulse duration of the (original 
or editcd) Channel tuple (ms) 

SI, of the (original or edited) 
Echosounder tuple (dB) 

Beam pattern factor ( h v 2  or 
BPF) of the (original or 
ediled) Channel tuple 
Value of B square (linear): 
10 log (Ilbeam pattern 
factor). 
Approximation for a circular 
transducer of active diameter 
d: Bav' or BPF= (LI xd)' 
Directivity index (DI) 
corresponding to the beam 
pattern factor of the (original 
or edited) Channel tuple 
(10 log (llbeam pattern 
factor). 
Approximation for a circular 
transducer of active diameter 
d: DI=l0 log (x d 1 L)' 
Two-way beam angle (i.e., 10 
log y )  of the (original or 
edited) Channel tuple in dB 
for the EK500 
3-dB beam width alongship of 
the (original or edited) 
Channel tuple (degree) 
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1 
Comment.? 

Optional field. This delay in nu is to correct 
for improper receiver delays used in the 
EK500 versions lower tlian version 5.3 
during calibration with a srandard sphere. 
('Tdel of Fernandes and Simmonds 1996. 
ICES CM 1996/8:17.) 
Optional field related to the previous one. 
Range recorded during the calibration with a 
standard sphere to use to cornpute the 
correction.. (rm of Fernandes and Simmonds 
1996. ]CES CM 1996/0:17.) 

This field is giving the offset between the 
depth and the range. II  is used at many places 
in CH1 and CH2. 

The sum of this field + the installatioii dcpth 
gives the minimurn sampled depth. where the 
ectio~ntegration can start. 

Al1 echo sarnples below this tliresliold are 
handled as having a nuIl backscattering 
coefficient. R y  default CH2 does iiot use any 
echointegration tlireshold by setiing this field 
[O an extremely low level (-200 dB). 
This field gives the average tim: offset of 
the PC clock relative to the universal t i m  
(GMT). If the PC clock was set to the local 
t i n ~ ,  this tiine offset gives local tim: lag 
relative IO ihe univeral time. 

Part of the file 

SPACE-TIME 
INFORMATION ON 
THE INTEGRATION 
GRII> 

Data example 
3.3 

-143.2 

26.5 

5 

6 

2.5 

12600 

Tag 
3-dB bedmwidth 
athwartship 

Receiving 
sensitivity 

Sv transducer 
gain 

Heceiver delay 

Kecorded range 
tu spliere 

Receiver 
baiidwidtli 

1nst:illatioii depth 
of transducer 

ülankiiig range 

Echointegration 
Sv threshold 

'rime difference 
between I'C clock 
and GMT 

Field description 

VR used for echointegration 
(dB) 

Sv transducer gain used for 
echointegration for the 
EKSW 
Receiver delay (ms) 

Recorded depth to sphere (m) 

Transducer installationdepth 
used for echointegration (m) 

The range (m) fmm the 
transducer for whicli the data 
were not recorded by CHI 
andlor ignored by CH2 for 
echointcgration as given in 
the dialog box 

Echointegration threshold (Sv 
in dH) 

Data example 
3.3 

-145.7 

27.4 

0.39 

10 

4.5 

1 0 

-60 

Field 

Average time difference in 
seconds between the PC 
clock and GMT as 
computed from GMT and 
CPU times of the Position 
tuples : 

description 
3-di3 beam width atbwartsliip 
of the (original or edited) 
Channel tuple (degree) 
VR of the (original or edited) 
Channel tuple (dB) 

Sv transducer gain of the 
(original or edited) Channel 
tuple for the EK5W 

Receiver bandwidth used 
during acquisition (kHz) 

Transducer installation depth 
of the (original or edited) 
Channel tuple (m) 

The range (m) fmm the 
transducer for whlch the data 
were either not output by the 
echosounder or not acquired 
by C H I ,  as indicated in the 
Echosounder tuple (only for 
the Biosonics 102 analog 
echosounder type) 
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Field description Datn example 1 Comments 
Ilf the lag between CPU and GMT times of 

Datn example 
183 

240 

Part of the file 

the Position tuplcs is not zero or ainultiple of 
30 min (1800 s), the PC clock was not 
properly set at acquisition or drifted since its 
last setiing. CH2 will correct for this error 
(here 183 s) for detemining Ihe Ume of the 
tiorizontal echointegration steps. The lag 
used by CH2 is the average lag for the whole 
file computed over al1 Position tuples. 
This field is required if one wants to 
synchronize (or align) the horizontal 
echointegration steps of this file with another 
file (for example, acquired by anoiher 
echosounder on the s a m  ship or anotiier 
ship). Here al1 steps will be synchronized for 
clle 0:04 min of the Iiour (by default rhere is 
no synchronisation. i.e.. the iiitegration steps 
start at the beginning of eacli Block of run. a 
run being a contiouoiis acquisitioii segmcni of 

Tnl: 
Tinie offset of PC 
clock 

Synchronizntion 
lime 

I>anil>ert latitude 
1 referencr 
1,anihert latitude 
2 rcferenre 

Field 
Time offset of the PC clock 
as estimated frorn GMT 
and CPU times of the 
Position tuple (s) : 

Synchronization time of the 
Iiour for the horizontal 
integralion step (s) 

1-anibert origiii 
latitude 
1,anihert origin 
longitude 

description 

Latitude 1 refereiicc for 
I,aml>ert projection: 
1,atitude Z reference for 
I.arnbert projection: 

1 Isystem: I 1 1 1 

Any depth strata can be defiried, even 
overlapping depth strata. N.B. The depth 
strata are defined according ta iheir depih not 

water colunin represents the inregration over the wliole 

Origin latitude of Lambert 
projection systeni: 
Origin longitude of 
1.anibert projection 

NSL (No. of 
surface-locked 

48.0 

46.0 

Lambert earth 
radius 

45.5 

-70.0 

Earth radius at equator in 
ni: 

63781 35 

No. of surface-lucked depth 
strata: 

a HAC file) 
Keferences for Lambert projection. 

(k, 

The units of this variable set the units of the 
Lambert ~roiection svstern we have chosen 

F 

fi 

12 

. - . . 
mettes in CH2. 
Variable nam:  NSL 
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I I category name 
ex.: capelin schoo~s I 

Data example Field description 
1 1 

Whole block = 
end-slan cumul Disi i I I 

L 

2 

NEIS 

Whole 
block 

cumul Time 1 

1 

I I I I I I I 
step 21 + 

1 1 I 1 I P 

hh 
(corrected PC tlme) 

,",..,, . , 
step2 
... 
step : 
NEIS* 

* 1 end of block 
block' , 

... 
step NEIS - 

, average weighted average weighted average weighted average weighted average weighted average weighted average weighted average 
ail $teps distano, , by the step by the step by the step by the slep by the step by the step by the step weighted by the 
m i ~ h t e d  average distances with no distances with no distances with no distances with no distances with no distances with no distances with no step distances 

of pings >O of pings >O of pings >O of pings > O of pings >O of pings > O of pings >O with no of pings 

latilude 
(deg.decimal) 

1 1 Tag 1 Field description 1 

date(aaae/mrnldd) 
(conected PC time) 

stari of e a d  step 
for that block 

mm 
(cooorcected PC tlme) 

Ptanl 

se 
(conected PC time) 

longitude 
( d g  decimal) 

end of block end of block end of block 

-Y.vY'., ,. 

start of each step 
for that block 
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lambn(m' 

2 

NEIS 

Whole 
block 

.,,an, 

y 

l 

, ,  1 

s t e p ~  1 
*.. 1 
step 
NEIS 
Who'e 1 end of block block i 

end of block end of block 

ex.: -1s 

dale(aaaa/mm/dd) 
(corrected PC tirne) 

No. of pings 
during thal sep 

end of block 

' that step (m 

end of block 

hh 
(coneded PC tirne) 

I 

(end-start) 

end of block end of block 

mm 
hrrecîed PC lime) 

end of block end of block 

ss 
(corr&ed PC lime) 

end of block 

1 

laillude 
(deg.decîmal) 

end of block 

longitude 
(deg.dedma1) 

end of block 

kVnbed(m) y lamban 

(end-starl) 

NO. 01 pings 
during lhal step 

' 

that atep lm 
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15. ANNEX 2: Development of TVG corrections due to the medium 

The s, correction of echo sarnples due to the effect of changes of sound speed and absorption 
coefficient on the TVG is: 

- GWG 2 
Sv:! - Sv1 - 

GTvc 1 

where indices 1 and 2 correspond to the values at acquisition and for echointegration, 
respectively. The scattering volume index, s,l, is related to the voltage at acquisition (Vml) 
through the relationship: 

Sv] =v;G] *Al 9 ( a  
where A is the calibration (or echointegration) constant. In this equation, the voltage at 
acquisition (Vml) is considered to have been compensated for the spreading of the sound wave 
by an accurate 20 log r TVG, except for the sound speed and absorption effect. The v;~, is 

related to the raw voltage (VI) and the 20 log r TVG by the equation: 

where k is a constant, ri is the range and bl is the absorption coefficient in nepers m-' and 

(k r, e 4 q 2  is Gnci. Ignoring the constant A (even if it involves the sound speed at range O), only 
considering the TVG correction, and combining equations 1,2, and 3, yields: 
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